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Configuring a BI infrastructure: Hands-on labs 
Published: May 26, 2011 
This series of articles gives you hands-on experience configuring the various business intelligence 
services available in Microsoft SharePoint Server 2010. This involves configuring a SharePoint Server 
2010 farm in an isolated test environment and then walking through a series of labs to complete the 
exact procedures necessary to configure the various business intelligence service applications. 
This series includes labs for configuring: 

• Excel Services            

• Visio Services            

• PerformancePoint Services            
In each case, there is a lab for configuring the service application and its associated accounts and 
additional labs for configuring data access. 
The first part of this series of labs is a set of labs to create the baseline environment on which the other 
labs build. This includes creating the SharePoint Server 2010 farm and configuring the Secure Store 
Service and creating a Business Intelligence Center. 
The baseline environment is built by using Windows Server 2008 Hyper-V technology. Although you 
could build the environment by using other virtualization technologies or physical hardware, those 
options are not discussed in these labs. 
To build the baseline environment, you need a computer that is running Windows Server 2008 or 
Windows Server 2008 R2 with Hyper-V enabled. 

 Note:  
Instructions for configuring Hyper-V are included in case you have not already configured it. 

The computer that you use for the baseline environment must have at least 8 GB of RAM and 100 GB 
of free disk space. Additional RAM will improve performance, as will distributing the virtual machines 
across multiple physical disks. 

 Important:  
The labs in this series give you hands-on experience configuring the business intelligence 
offerings in SharePoint Server 2010 by using an isolated Hyper-V test environment. These labs 
should not be used to create a production deployment of SharePoint Server 2010 on Hyper-V. 
For information about how to deploy your production SharePoint Server 2010 farm by using 
Hyper-V, see Virtual machine guidance (SharePoint Server 2010). 

To get started with the labs, see Create a baseline environment for a BI test environment. 
  

http://technet.microsoft.com/library/e7fc992d-3c51-4b65-bbf4-0c12100aa36e(Office.14).aspx�


 

 

Create a baseline environment for a BI test 
environment 
Published: May 26, 2011 
This series of hands-on labs describe how to create a Microsoft SharePoint Server 2010 farm in an 
isolated Hyper-V test environment. This is the baseline environment that you will use for completing the 
further labs for configuring the business intelligence service applications available in SharePoint Server 
2010. 

 Important:  
The labs in this series give you hands-on experience configuring the business intelligence 
offerings in SharePoint Server 2010 by using an isolated Hyper-V test environment. These labs 
should not be used to create a production deployment of SharePoint Server 2010 on Hyper-V. 
For information about how to deploy your production SharePoint Server 2010 farm by using 
Hyper-V, see Virtual machine guidance (SharePoint Server 2010). 

Creating the baseline environment consists of the following steps: 

1. Configure Hyper-V on the host computer 

2. Set up a virtual machine with a domain controller for the virtual test domain 

3. Add additional virtual machines to the virtual domain 

4. Set up accounts that are needed to deploy the SharePoint Server 2010 farm 

5. Set up Microsoft SQL Server 2008 R2 

6. Install and configure SharePoint Server 2010 

7. Configure the Secure Store Service 

8. Create a Business Intelligence Center 
A hands-on lab is provided for each of these steps. 

 Note:  
These labs assume that you are using Windows Server 2008 R2 and SQL Server 2008 R2. 
Windows Server 2008 and Microsoft SQL Server 2008 can also be used, although there may 
be some minor differences in procedures. Also, you may be unable to complete some labs, 
such as those using PowerPivot for SharePoint 2010, if you are using SQL Server 2008. 

To get started creating the baseline environment, see Hyper-V quick start for creating a BI test 
environment, or, if you have already configured Hyper-V, see Set up a domain controller for a BI test 
environment. 
  

http://technet.microsoft.com/library/e7fc992d-3c51-4b65-bbf4-0c12100aa36e(Office.14).aspx�


 

 

Hyper-V quick start for creating a BI test 
environment 
Published: May 26, 2011 

 Important:  
This article is part of the Configuring a BI infrastructure: Hands-on labs series. This is the first 
article in the series that describes how to set up a baseline test environment for the labs. The 
articles in this series should be read sequentially, starting with this article, as the procedures in 
each build on those in the last. 

Hyper-V is the Microsoft virtualization solution. It is built into most versions of Windows Server 2008 
and Windows Server 2008 R2. It offers an ideal platform to deploy a full-scale Microsoft SharePoint 
Server 2010 test environment for business intelligence without the need to purchase multiple servers.  
This article describes the steps that you must follow to enable Hyper-V and create virtual machines. If 
you are already familiar with Hyper-V, you can move on the next article, Set up a domain controller for a 
BI test environment. 

Enable Hyper-V 
The first step is to enable Hyper-V. Hyper-V is a server role on Windows Server 2008 or Windows 
Server 2008 R2. To enable it, log on to the computer as an administrator and perform the following 
procedure. 

To enable Hyper-V 
1. Click Start, click Administrative Tools, and then click Server Manager. 
2. In the left pane, click Roles. 

3. In the right pane, click Add Roles. 

4. If the Before You Begin page is displayed, click Next. 
5. On the Select Server Roles page, select the Hyper-V check box, and then click Next. 
6. On the Hyper-V page, click Next. 
7. On the Create Virtual Networks page, leave the network adapter check boxes cleared, and then 

click Next. 
8. On the Confirm Installation Selections page, click Install. 
9. On the Installation Results page, click Close. 

10. Restart the server. 

Configure a virtual network 
Once Hyper-V is enabled, you must create a virtual network within Hyper-V so that the virtual machines 
can communicate with one another. Two virtual networks are required: 

• An internal virtual network that allows the virtual machines to communicate with one another 



 

• An external virtual network that allows the virtual machines to communicate with your corporate 
network and the Internet (This is required specifically during installation of Microsoft SharePoint 
Server 2010 to download the prerequisites.) 

To configure an internal network, perform the following procedure. 

To configure an internal virtual network 
1. Click Start, click Administrative Tools, and then click Hyper-V Manager. 
2. In the left pane, click the node of the local computer. 

3. In the right pane, click Virtual Network Manager. 
4. Click Internal, and then click Add. 

5. In the Name text box, type Internal Network. 

6. Ensure that the Internal only option is selected, and then click OK. 
Once the internal network is created, create an external network by using the following procedure. 

To configure an external virtual network 
1. Click Start, click Administrative Tools, and then click Hyper-V Manager. 
2. In the left pane, click the node of the local computer. 

3. In the right pane, click Virtual Network Manager. 
4. Click External, and then click Add. 

5. In the Name text box, type External Network. 

6. Select the External option, and select a network adapter from the drop-down list. 

7. Select the Allow management operating system to share this network adapter check box. 

8. Click OK. 

9. On the Apply Network Changes dialog box, click Yes. 

Create virtual machines 
When you have completed network configuration, you can start adding virtual machines to Hyper-V. To 
complete all the steps in this series of articles, you need the following virtual machines: 
  

Virtual machine Operating System Description RAM 

Contoso-DC Windows Server 2008 R2                Domain controller 512 MB 

Contoso-SQL Windows Server 2008 R2                Microsoft SQL Server 2008 
R2                

2048 MB 

Contoso-AppSrv Windows Server 2008 R2                SharePoint Server 2010                2048 MB 

Contoso-Client Windows 7 Windows 7 1536 MB 

  

 Note:  
To perform the steps in the Excel Services labs, you must install Microsoft Excel 2010 on the 
Contoso-Client virtual machine. To perform the steps in the Visio Services labs, you must install 



 

Microsoft Visio Professional 2010 or Microsoft Visio Premium 2010 on the Contoso-Client 
virtual machine. 

Perform the following procedure for each virtual machine that you want to create. 

To create a virtual machine 
1. Click Start, click Administrative Tools, and then click Hyper-V Manager. 
2. In the left pane, click the node of the local computer. 

3. In the right pane, click New, and then click Virtual Machine. 

4. On the Before You Begin page, click Next. 
5. In the Name text box, type the name for the virtual machine from the previous table, and then click 

Next. 

 Important:  
The Name text box specifies a name for the virtual machine in Hyper-V. This does not 
configure the computer name for the virtual machine itself. After you install the operating 
system on the virtual machine, you must configure the computer name to match the name 
in the previous table. 

6. On the Assign Memory page, type the appropriate memory value from the table above. 

 Note:  
The memory table assumes that you are using a host computer with 8 GB RAM. If you 
have additional RAM available, we recommend that you increase the RAM allocated to 
your virtual machines, particularly to the Contoso-AppSrv and Contoso-SQL virtual 
machines. 

7. On the Configure Networking page, select External Network from the drop-down list, and then 
click Next. 

8. On the Connect Virtual Hard Disk page, leave the default values, and then click Next. 
9. On the Installation Options page, leave the Install an operating system later option selected and 

then click Next. 
10. Click Finish. 

Load an operating system 
Once a virtual machine is created that has an empty hard disk, the next step is to install an operating 
system. Product Short Name 2010 requires Windows Server 2008 or Windows Server 2008 R2. We 
recommend that you use Windows Server 2008 or Windows Server 2008 R2 for each server virtual 
machine that you create. Perform the following procedure to install an operating system on a virtual 
machine. 

To load an operating system on a virtual machine 
1. In Hyper-V Manager, right-click the virtual machine on which you want to load an operating system, 

and then click Settings. 

2. In the left pane, click DVD Drive. 

3. In the right pane, select the Image file option. 

4. Click Browse, and locate the ISO file that contains the operating system. 



 

5. Click OK. 

6. In Hyper-V Manager, double-click the virtual machine on which you want to load the operating 
system. 

7. In the Virtual Machine Connection window, click the Start icon on the toolbar. 

8. Install the operating system. 
When you have created all of the virtual machines that you need and installed operating systems on 
each, the next step is to set up a domain controller. See the next article, Set up a domain controller for 
a BI test environment. 
  



 

 

Set up a domain controller for a BI test 
environment 
Published: May 26, 2011 

 Important:  
This article is part of the baseline setup for the Configuring a BI infrastructure: Hands-on labs 
series. To complete the steps in this article, you must first have completed Hyper-V quick start 
for creating a BI test environment. 

This article describes how to set up a domain controller on a virtual machine that is running Windows 
Server 2008 or Windows Server 2008 R2. This article and the remaining articles in this series assume 
that you have created the following infrastructure of virtual machines: 
  

Virtual machine Operating system 

Contoso-DC Windows Server 2008 or Windows Server 2008 
R2 

Contoso-SQL Windows Server 2008 or Windows Server 2008 
R2 

Contoso-AppSrv Windows Server 2008 or Windows Server 2008 
R2 

Contoso-Client Windows 7 

  
To perform the procedures in this article, log on to the Contoso-DC virtual machine as an administrator. 

Video demonstration 
This video shows how to set up the Contoso-DC domain controller for use in these labs. 
  

 Running time: 4:58 

  Watch the video. 

  For an optimal viewing experience, 
download the video. 
Right-click the link, and then click Save Target As 
to download a copy. Clicking the link opens a 
.wmv file in the default video viewer for full-
resolution viewing. 

  

http://go.microsoft.com/fwlink/p/?LinkId=223437�
http://go.microsoft.com/fwlink/p/?LinkId=223384�


 

Configure the domain controller 
The first step in setting up a domain controller is to set a static IP address. Domain controllers require 
static IP addresses to function correctly. 

 Important:  
Before you start, ensure that the network connection on the Contoso-DC virtual machine is set 
to Internal Network. 

In this series of articles, we are using the 10.0.0.0 – 10.255.255.255 IP address range that is reserved 
for private networks. This address range is used on the internal network for the virtual domain. In 
situations where the External Network is used (such as for downloading Microsoft SharePoint Server 
2010 prerequisites from the Internet), we assume that your existing corporate network will assign an 
appropriate IP address to the network adapter by using dhcp. 
Depending on the network configuration, you may be able to use the 10.0.0.0 – 10.255.255.255 IP 
address range on a network adapter connected to your corporate network. This would enable you to 
span the virtual machines across multiple physical host computers. However, you should beware of 
potential IP address conflicts when you use static IP addresses of any kind on a shared network. 
Perform the following procedure to configure a static IP address. 

To configure a static IP address 
1. Click Start, and then click Control Panel. 
2. Click Network and Internet. 
3. Click Network and Sharing Center. 
4. Click Change Adapter Settings. 

5. Right-click the local area connection, and then click Properties. 

6. On the Local Area Connection Properties dialog box, clear the Internet Protocol Version 6 
(TCP/IPv6) check box. 

7. Select Internet Protocol Version 4 (TCP/IPv4) and then click Properties. 

8. On the Internet Protocol Version 4 (TCP/IPv4) Properties dialog box, select the Use the 
following IP address option, and then type 10.0.0.1 in the IP address box. 

9. In the Subnet mask box, type 255.0.0.0. 

10. Select the Use the following DNS server addresses option, and then type 10.0.0.1 in the 
Preferred DNS server box. 

11. Click OK. 

12. Click Close. 

13. Click Close. 
Once you have set the static IP address, you are ready to promote the virtual machine to a domain 
controller. This is performed at a command prompt by using the dcpromo command. 

 Note:  
The password that you chose for the local administrator account for this virtual machine 
becomes the domain administrator password as soon as the domain controller has been 
configured. 

Perform the following procedure to configure the domain controller. 



 

To configure the domain controller 
1. Click Start, click Run, type dcpromo, and then click OK. 

2. On the Welcome to the Active Directory Domain Services Installation Services page, click Next. 
3. On the Operating System Compatibility page, click Next. 
4. On the Choose a Deployment Configuration page, select the Create a new domain in a new 

forest option, and then click Next. 
5. In the Name the Forest Root Domain page, type contoso.local in the FQDN of the forest root 

domain box, and then click Next. 
6. On the Set Forest Functional Level page, select Windows Server 2008 from the dropdown list, and 

then click Next. 
7. On the Set Domain Functional Level page, select Windows Server 2008 from the dropdown list, 

and then click Next. 
8. On the Additional Domain Controller Options page, ensure that the DNS server check box is 

selected, and then click Next. 
9. On the warning dialog box, click Yes. 

10. On the Location for Database, Log Files, and SYSVOL page, keep the default values, and then 
click Next. 

11. On the Directory Services Restore Mode Administrator Password page, type and confirm a 
password, and then click Next. 

12. On the Summary page, click Next. 
13. When the wizard has finished running, click Finish. 

14. Restart the virtual machine. 
Once the domain controller setup is complete, you can add the other virtual machines to the domain. 
See the next article, Add a virtual machine to the virtual domain in a BI test environment. 
  



 

 

Add a virtual machine to the virtual domain in a 
BI test environment 
Published: May 26, 2011 

 Important:  
This article is part of the baseline setup for the Configuring a BI infrastructure: Hands-on labs 
series. To complete the steps in this article, you must first have completed Set up a domain 
controller for a BI test environment. 

This article describes adding virtual machines to the contoso.local domain. For Microsoft SharePoint 
Server 2010 to function correctly, you must add the remaining virtual machines to the domain before 
you install Microsoft SQL Server and SharePoint Server 2010. 
For this series of articles, we assume the following IP address, operating system, and minimum 
memory configuration for the domain: 
  

Virtual machine Operating system IP address RAM 

Contoso-DC Windows Server 2008 R2              10.0.0.1 512 
MB 

Contoso-SQL Windows Server 2008 R2              10.0.0.2 2048 
MB 

Contoso-AppSrv Windows Server 2008 R2              10.0.0.3 2048 
MB 

Contoso-Client Windows 7 10.0.0.4 1536 
MB 

  

 Note:  
The memory configurations in this table are the minimum recommended for this configuration. 
They enable you to deploy this environment on a host computer that has 8 gigabyte (GB) of 
RAM. If you experience performance issues, add memory, especially to the Contoso-AppSrv 
virtual machine. 

 Note:  
To perform the steps in the Excel Services labs, you must install Microsoft Excel 2010 on the 
Contoso-Client virtual machine. To perform the steps in the Visio Services labs, you must install 
Microsoft Visio Professional 2010 or Microsoft Visio Premium 2010 on the Contoso-Client 
virtual machine. 

Video demonstration 
This video shows how to add a virtual machine to the domain. 
  



 

 Running time: 3:55 

  Watch the video. 

  For an optimal viewing experience, 
download the video. 
Right-click the link, and then click Save Target As 
to download a copy. Clicking the link opens a 
.wmv file in the default video viewer for full-
resolution viewing. 

  

Configuring the virtual machine 
Perform the following procedure for the Contoso-SQL, Contoso-AppSrv, and Contoso-Client virtual 
machines. Use the IP addresses listed in the table. 

 Important:  
As with the domain controller, each virtual machine must have the virtual network adapter set to 
Internal Network before you configure the static IP address. 

To configure a static IP address 
1. Click Start, and then click Control Panel. 
2. Click Network and Internet. 
3. Click Network and Sharing Center. 
4. Click Change Adapter Settings. 

5. Right-click local area connection, and then click Properties. 

6. On the Local Area Connection Properties dialog box, clear the Internet Protocol Version 6 
(TCP/IPv6) check box. 

7. Select Internet Protocol Version 4 (TCP/IPv4), and then click Properties. 

8. On the Internet Protocol Version 4 (TCP/IPv4) Properties dialog box, select the Use the 
following IP address option, and then type the IP address for the virtual machine that you are 
configuring in the IP address box. 

9. In the Subnet mask box, type 255.0.0.0. 

10. Select the Use the following DNS server addresses option, and then type 10.0.0.1 in the 
Preferred DNS server box. 

11. Click OK. 

12. Click Close. 
Once the static IP address has been configured for each virtual machine, you can join the virtual 
machine to the contoso.local domain. Perform the following procedure on the Contoso-SQL, Contoso-
AppSrv, and Contoso-Client virtual machines. 

http://go.microsoft.com/fwlink/p/?LinkId=223438�
http://go.microsoft.com/fwlink/p/?LinkId=223383�


 

 Note:  
The default Windows Server 2008 firewall settings can interfere with the ability to join the 
computer to a domain. If you have problems joining the virtual machines to the domain, contact 
a network administrator for help. Because this is a private network that is not connected to the 
corporate network or the Internet, you can also consider turning off Windows Firewall. 

To connect to the domain 
1. Click Start, right-click Computer, and then click Properties. 

2. Under Computer, name, domain, and workgroup settings, click Change settings. 

3. On the Computer Name tab, click Change. 

4. Select the Domain option, and then type contoso.local. 

 Important:  
Make sure the Computer name in this dialog box matches the virtual machine name in the 
previous table. If it does not, repeat this procedure after you join the domain and change 
the computer name to match the name in the table. 

5. Click OK. 

6. In the Windows Security dialog box, type Contoso\Administrator for the user name, and type the 
password for that account. (This is the administrator password that you configured for the Contoso-
DC virtual machine.) 

7. Click OK. 

8. On the Welcome to the domain dialog box, click OK. 

9. On the Computer Name/Domain Changes dialog box, click OK. 

10. Click Close. 

11. Restart the virtual machine. 
Once the virtual machines have been joined to the contoso.local domain, the next step is to set up the 
domain accounts that you need for SharePoint Server 2010 and its associated applications. See the 
next article, Set up accounts for a BI test environment. 
  



 

 

Set up accounts for a BI test environment 
Published: May 26, 2011 

 Important:  
This article is part of the baseline setup for the Configuring a BI infrastructure: Hands-on labs 
series. To complete the steps in this article, you must first have completed Add a virtual 
machine to the virtual domain in a BI test environment. 

Video demonstration 
This video shows how to add the required accounts for use in these labs. 
  

 Running time: 5:45 

  Watch the video. 

  For an optimal viewing experience, 
download the video. 
Right-click the link, and then click Save Target As 
to download a copy. Clicking the link opens a 
.wmv file in the default video viewer for full-
resolution viewing. 

  

Configure accounts 
To configure Microsoft SharePoint Server 2010 in a server farm environment, there are several domain 
accounts needed to provide the most optimal and secure configuration. This article describes how to 
create accounts and groups at the domain level for use in the remaining configuration steps in this 
series of articles. 
  

Account Domain account Description 

SQL Server Administrator Contoso\SQLAdmin Administrator account for SQL 
Server 2008. Local Administrator 
on Contoso-SQL. 

Farm Administrator Contoso\FarmAdmin Farm Administrator for the 
SharePoint Server 2010 farm. 
Local Administrator on Contoso-
AppSrv. 

SQL Server service account Contoso\SQLSvc Domain account for running SQL 

http://go.microsoft.com/fwlink/p/?LinkId=223439�
http://go.microsoft.com/fwlink/p/?LinkId=223382�


 

Account Domain account Description 

Server services. 

Client user account Contoso\John.Woods Domain user account for testing 
BI functionality. 

Client user account Contoso\Susan.Burk Domain user account for testing 
BI functionality. 

Client user account Contoso\Cindy.White Domain user account for testing 
BI functionality. 

Client user account Contoso\David.Hamilton Domain user account for testing 
BI functionality. 

Client user account Contoso\Jill.Frank Domain user account for testing 
BI functionality. 

  
To create these accounts, you must be logged on to Contoso-DC as the domain administrator 
(contoso\administrator). 

 Note:  
Additional accounts will be created for SharePoint Server 2010 service applications and for 
data access as part of the other hands-on labs in this series. 

Perform the following procedure for each account listed in the table. 

To create an Active Directory account 
1. Click Start, click Administrative Tools, and then click Active Directory Users and Computers. 

2. Expand the domain node. 

3. Right-click Users, click New, and then click User. 
4. For a user account (for example, John Woods or Susan Burk) type the first and last name in the 

First name and Last name text boxes. For a service account, leave these text boxes blank. 

5. In the Full name box, for service accounts, type the name of the account (for example, 
FarmAdmin). 

 Note:  
This text box is automatically populated for user accounts when you specify the First name 
and Last name fields. 

6. In the User logon name box, type the logon name for the account. For service accounts, this is the 
same as Full name; for user accounts this should be in the format first.last (for example, 
Susan.Burk). 

7. Click Next. 
8. Type and confirm a password for the account. 

9. Clear the User must change password at next logon check box. 

10. Select the Password never expires check box. 

11. Click Next. 
12. Click Finish. 
Leave Active Directory Users and Computers open for the next procedure. 



 

Once you have created the user accounts listed in the previous table, you must create an Active 
Directory group to contain these accounts. These groups are used to grant access to the Business 
Intelligence Center that we will create later in this series of labs. 
We will create the groups listed in the following table. 
  

Group Description 

BICenterRead Provides Read access to the BI 
Center. 

BICenterContribute Provides Contribute access to the BI 
Center. 

BICenterDesign Provides Design access to the BI 
Center. 

BICenterFullControl Provides Full Control access to the BI 
Center. 

  
Use the following procedure to create each Active Directory group. 

To create an Active Directory group 
1. In Active Directory Users and Computers, right-click Users, click New, and then click Group. 

2. In the Group name text box, type the name of the group that you are creating from the previous 
table. 

3. Click OK. 
Leave Active Directory Users and Computers open for the next procedure. 
Once the groups have been created, you must add a user to each group, as specified in the following 
table. 
  

Add this user To this group 

Contoso\John.Woods BICenterRead 

Contoso\Susan.Burk BICenterContribute 

Contoso\Cindy.White BICenterDesign 

Contoso\David.Hamilton BICenterFullControl 

  
Use the following procedure to add the specified user to each group. 

To add users to an Active Directory group 
1. In Active Directory Users and Computers, click Users. 

2. In the pane on the right side, double-click the group to which you want to add a user. 

3. On the Members tab, click Add. 

4. In the Enter the object names to select box, type the name of the user whom you want to add to 
the group (for example, contoso\john.woods for the BICenterRead group). 



 

5. Click OK. 

6. Confirm that the appropriate user is now listed on the Members tab, and then click OK. 
After you have created the required user accounts and groups and populated the groups in the Active 
Directory directory service, you can start to install software. The first step is to install SQL Server 2008. 
See the next article, Set up SQL Server for a BI test environment. 
  



 

 

Set up SQL Server for a BI test environment 
Published: May 26, 2011 

 Important:  
This article is part of the baseline setup for the Configuring a BI infrastructure: Hands-on labs 
series. To complete the steps in this article, you must first have completed Set up accounts for 
a BI test environment. 

This article describes how to install and configure Microsoft SQL Server 2008 for use with Microsoft 
SharePoint Server 2010. SharePoint Server 2010 requires one of the following versions of Microsoft 
SQL Server: 

• Microsoft SQL Server 2008 R2            

• Microsoft SQL Server 2008 with Service Pack 1 (SP1) and Cumulative Update 2            

• Microsoft SQL Server 2005 SP3 with Cumulative Update package 3 for SQL Server 2005 Service 
Pack 3 

This article describes installing and configuring SQL Server 2008 R2. 

Video demonstration 
This video shows how to set up SQL Server 2008 R2 on the Contoso-SQL virtual machine. 
  

 Running time: 11:13 

  Watch the video. 

  For an optimal viewing experience, 
download the video. 
Right-click the link, and then click Save Target As 
to download a copy. Clicking the link opens a 
.wmv file in the default video viewer for full-
resolution viewing. 

  

Configure a local administrator 
We recommend that you install SQL Server 2008 R2 while logged on with the SQL Server administrator 
domain account (Contoso\SQLAdmin). Prior to doing this, you must add this account to the 
Administrators group on the Contoso-SQL virtual machine. 
Log on to the Contoso-SQL virtual machine with the domain administrator account 
(Contoso\administrator) and perform the following procedure to add the Contoso\SQLAdmin account to 
the local Administrators group. 

http://go.microsoft.com/fwlink/p/?LinkId=223440�
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To add a local administrator 
1. Log on to the virtual machine where you want to install SQL Server as a domain administrator 

(Contoso\Administrator). 

2. Click Start, click Administrative tools, and then click Computer Management. 
3. Expand Local Users and Groups, and then click Groups. 

4. In the pane on the right side, right-click Administrators, and then click Properties. 

5. Click Add. 

6. Type the name of the SQL Server administrator account (Contoso\SQLAdmin), and then click OK. 

7. Click OK. 

8. Log off the virtual machine. 
To perform the remaining procedures in this article, log on to the Contoso-SQL virtual machine with the 
Contoso\SQLAdmin account. 

Install SQL Server 2008 R2 
The first step is to install SQL Server 2008. SQL Server 2008 requires .NET Framework version 3.5. If 
.NET Framework 3.5 is currently not installed, you must install it or enable it as a feature in Windows 
Server 2008 before you continue.  
Perform the following procedure to install SQL Server 2008 on Contoso-SQL. 

To install SQL Server 2008 R2 
1. Attach the SQL Server 2008 R2 DVD to the virtual machine DVD drive. 

2. Log on to the Contoso-SQL virtual machine as the SQL Server administrator (Contoso\SQLAdmin). 

3. On the SQL Server DVD, double-click setup.exe. 

4. If a SQL Server 2008 R2 setup requires Microsoft .NET Framework dialog box is displayed, 
click OK. 

5. In the SQL Server Installation Center, in the pane on the left side, click Installation. 

6. In the pane on the right side, click New installation or add features to an existing installation. 

7. On the Setup Support Rules page, click OK. 

8. On the product key page, type your product key, and then click Next. 
9. On the License Terms page, review the license agreement and, if you agree, select the I accept 

the license terms check box, and then click Next. 
10. On the Setup Support Files page, click Install. 
11. On the Setup Support Rules page, click Next. 
12. On the Setup Role page, select the SQL Server Feature Installation option, and then click Next. 
13. On the Feature Selection page, select the following check boxes: 

• Database Engine Services 

• Analysis Services 

• Reporting Services 

• Management Tools - Complete 



 

 Note:  
We also recommend that you install SQL Server Books Online. 

14. Click Next. 
15. On the Installation Rules page, click Next. 
16. On the Instance Configuration page, leave the Default instance option selected, and then click 

Next. 
17. On the Disk Space Requirements page, click Next. 
18. On the Server Configuration page, change the Startup Type for SQL Server Agent from Manual 

to Automatic. 

19. Click Use the same account for all SQL Server services, type Contoso\SQLSvc for the 
Account Name, type the password for that account, and then click OK. 

20. Click Next. 
21. On the Database Engine Configuration page, select the Mixed Mode option, and type and confirm 

a password for the built-in SQL Server administrator account.  

22. Click Add Current User to add the current user account as a SQL Server administrator. 

23. Click Next. 
24. On the Analysis Services Configuration page, click Add Current User to add the current user 

account as an Analysis Services administrator. 

25. Click Next. 
26. On the Reporting Services Configuration page, select the Install the native mode default 

configuration option, and then click Next.  
27. On the Error and Usage Reporting page, leave the default values and then click Next. 
28. On the Installation Rules page, click Next. 
29. On the Ready to Install page, click Install. 
30. When the setup process is complete, click Close. 

Configure logins 
When SQL Server 2008 R2 has been installed, the next step is to create a logon for the Farm 
Administrator account (Contoso\FarmAdmin) to provide the necessary permissions for SharePoint 
Server 2010 installation and configuration. 
Perform the following procedure to create a logon for the Farm Administrator account. 

To create a logon for the Farm Admin 
1. Click Start, click All Programs, click Microsoft SQL Server 2008 R2, and then click SQL Server 

Management Studio. 

2. On the Connect to Server dialog box, type Contoso-SQL in the Server name text box, and 
connect to the Database Engine. 

3. In SQL Server Management Studio, expand Security, right-click Logins, and then click New 
Login.  

4. In the Login name box, type Contoso\FarmAdmin. 

5. In the pane on the left side, click Server Roles. 



 

6. Select the sysadmin and dbcreator server roles. 

7. Click OK. 

Configure SQL Server network protocols 
SharePoint Server 2010 requires that SQL Server 2008 allow connections over TCP/IP. Depending on 
your SQL Server configuration, this may be enabled by default. Use the following procedure to confirm 
that TCP/IP access is enabled. 

To enable connections over TCP/IP 
1. Click Start, click All Programs, click Microsoft SQL Server 2008 R2, click Configuration Tools, 

and then click SQL Server Configuration Manager. 
2. Expand the SQL Server Network Configuration node. 

3. Click Protocols for MSSQLSERVER. 

4. In the Protocol Name list, confirm that TCP/IP is Enabled. If it is not, right-click TCP/IP, and then 
click Enable. 

5. If TCP/IP was disabled, restart the SQL Server service for the new setting to take effect. 

 Note:  
To restart the service, in Management Studio, right click the Contoso-SQL node at the top 
of Object Explorer, and then click Restart. 

After SQL Server configuration is complete, the next step is to install SharePoint Server 2010 on the 
Contoso-AppSrv virtual machine. See the next article, Install and configure SharePoint Server 2010 for 
a BI test environment. 

Install the Contoso sample database 
Several of the labs in this series use sample data from the Microsoft Contoso BI Demo Dataset for 
Retail Industry. To install this dataset, you first have to download the files from the Microsoft Download 
Center (http://go.microsoft.com/fwlink/p/?LinkId=219170). Download ContosoBIdemoBAK.exe. 
You must install this file on the Contoso-SQL virtual machine. You can put the file on the virtual 
machine by using one of the following methods: 

• Create an ISO file that contains the downloaded file and attach it to the Virtual DVD drive on 
Contoso-SQL. 

• Burn the file onto a physical DVD and place the DVD in the DVD drive of the host computer that is 
running Hyper-V. Then, connect the Contoso-SQL virtual machine to the physical DVD drive. 

• Create a network file share that contains the file, and then connect to that file share from Contoso-
SQL. 

 Note:  
You may have to add an additional virtual network adapter to Contoso-SQL to gain access 
to a file share that is outside the Contoso domain. 

Which method that you choose depends largely on your environment. 
Once you have downloaded the file and copied it to the Contoso-SQL virtual machine, use the following 
procedures to install the sample data. 
First, create a folder for the backup files. 

http://go.microsoft.com/fwlink/p/?LinkId=219170�
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To create a backup folder 
1. Click Start, click All Programs, click Accessories, and then click Windows Explorer. 
2. In the pane on the left side, click Computer. 
3. In the pane on the right side, double-click Local Disk (C:). 
4. Right-click the pane on the right side, click New, and then click Folder. 
5. Name the folder BackupFiles. 
Once the folder has been created, you can unzip the contents of the ContosoBIdemoBAK.exe file to 
that folder. Use the following procedure to unzip the ContosoBIdemoBAK.exe file and restore the 
database backups to SQL Server. 

To install the ContosoRetailDW database 
1. On the Contoso-SQL virtual machine, locate the ContosoBIdemoBAK.exe file. 

2. Double-click ContosoBIdemoBAK.exe. 

3. On the WinZip Self-Extractor dialog box, click Browse. 

4. On the Browse for folder dialog box, browse to the C:\BackupFiles folder, and then click OK. 

5. On the WinZip Self-Extractor dialog box, click Unzip. 

6. On the success dialog box, click OK. 

7. Click Close. 

8. Open SQL Server Management Studio and connect to the Database Engine. 

9. Right-click Databases, and then click Restore database. 

10. In the To database text box, type ContosoRetailDW. 

11. Select the From device option, and then click the browse button. 

12. On the Specify Backup dialog box, click Add. 

13. Browse to the C:\BackupFiles folder, click ContosoRetailDW.bak, and then click OK. 

14. On the Specify Backup dialog box, click OK. 

15. Select the check box for ContosoRetailDW-Full Database Backup, and then click OK. 

16. On the success dialog box, click OK.  
  



 

 

Install and configure SharePoint Server 2010 for 
a BI test environment 
Published: May 26, 2011 

 Important:  
This article is part of the baseline setup for the Configuring a BI infrastructure: Hands-on labs 
series. To complete the steps in this article, you must first have completed Set up SQL Server 
for a BI test environment. 

This article describes how to install SharePoint Server 2010 on the Contoso-AppSrv virtual machine. 

Video demonstration 
This video shows how to set up the Contoso-DC domain controller for use in these labs. 
  

 Running time: 8:40 

  Watch the video. 

  For an optimal viewing experience, 
download the video. 
Right-click the link, and then click Save Target As 
to download a copy. Clicking the link opens a 
.wmv file in the default video viewer for full-
resolution viewing. 

  

Install SharePoint Server 2010 
The first step in installing Microsoft SharePoint Server 2010 is to install the SharePoint Server 2010 
prerequisites. These can be automatically downloaded from the Internet and installed by the SharePoint 
Server 2010 prerequisite installer tool that is built into SharePoint Server 2010 setup. 

 Important:  
The Enterprise edition of SharePoint Server 2010 is required for the scenarios in this hands-on 
labs series. 

For the Contoso-AppSrv virtual machine to be able to download the necessary updates, you must add a 
second virtual network connection to the Contoso-AppSrv virtual machine and connect it to the External 
Network connection. 

http://go.microsoft.com/fwlink/p/?LinkId=223441�
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 Note:  
To add a network connection, the virtual machine must be turned off. When the virtual machine 
is off, right-click the virtual machine in Virtual Machine Manager, and then click Settings. On 
the Settings page, select Network Adapter in the Add Hardware section, and connect it to 
External Network. 

 Note:  
If you cannot create an internet connection from the virtual machine, you can download the 
prerequisites from the Internet and create an ISO file that you can attach to the virtual machine 
DVD drive. For more information about what prerequisites are required, see Determine 
hardware and software requirements (SharePoint Server 2010). For information about how to 
install the prerequisites from a network share, see Install prerequisites from a network share 
(SharePoint Server 2010). 

For installation of SharePoint Server 2010 and its prerequisites, use the Contoso\FarmAdmin account. 
This account must be a local administrator on the Contoso-AppSrv virtual machine. 
Log on to the Contoso-AppSrv virtual machine with the domain administrator account 
(Contoso\administrator) and perform the following procedure to add the Contoso\FarmAdmin account to 
the Administrators group. 

To add a local administrator 
1. Log on to the virtual machine where you want to install SharePoint Server 2010 by using the 

Contoso\Administrator domain administrator account. 

2. Click Start, click Administrative tools, and then click Computer Management. 
3. Expand Local Users and Groups, and then click Groups. 

4. In the pane on the right side, right-click Administrators, and then click Properties. 

5. Click Add. 

6. Type the name of the SQL Server administrator account (Contoso\FarmAdmin), and then click OK. 

7. Click OK. 

8. Log off the virtual machine. 
To perform the remaining procedures in this article, log on to the Contoso-AppSrv virtual machine with 
the Contoso\FarmAdmin account. 
To install the SharePoint Server 2010 prerequisites, perform the following procedure. 

To install SharePoint Server 2010 prerequisites 
1. On the SharePoint Server 2010 DVD, run default.hta. 

2. On the SharePoint Server 2010 opening page, click Install software prerequisites. 

3. Follow the wizard to complete installation of all prerequisites. 

 Note:  
Depending on your configuration, you may have to restart your computer during this 
process. 

4. When the wizard has finished, click Finish. 
Once the prerequisites have been installed, you can install SharePoint Server 2010 itself. Perform the 
following procedure to install SharePoint Server 2010 on Contoso-AppSrv. 

To install SharePoint Server 2010 
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1. On the SharePoint Server 2010 DVD, run default.hta. 

2. On the SharePoint Server 2010 opening page, click Install SharePoint Server. 
3. On the Enter your Product Key page, type your product key, and then click Continue. 

4. On the Read the Microsoft Software License Terms page, read the license agreement and accept 
the terms by selecting the I accept the terms of this agreement check box. 

5. Click Continue. 

6. On the Choose the installation you want page, click Server Farm. 

7. On the Server Type page, select the Complete – Install all components option. 

8. Click Install Now. 

9. On the Run Configuration Wizard page, leave the Run the SharePoint Products and 
Technologies Configuration Wizard now check box selected, and then click Close. 

10. On the Welcome to SharePoint Products page, click Next. 
11. On the warning dialog box, click Yes. 

12. On the Connect to a server farm page, select the Create a new server farm option, and then click 
Next. 

13. On the Specify Configuration Database Settings page: 

a) In the Database server box, type the name of the database server (Contoso-SQL) where 
you want to host the SharePoint Server 2010 databases. 

b) In the Database name text box, keep the default database name of SharePoint_Config. 

c) Type the user name and password of the database access account (Contoso\FarmAdmin).  

d) Click Next. 

 Note:  
If the wizard is unable to connect to Contoso-SQL, check the firewall settings in Windows 
Server. 

14. On the Specify Farm Security Settings page, type and confirm a pass phrase for the farm, and then 
click Next. 

15. On the Configure SharePoint Central Administration web Application page, select the Specify port 
number check box, and type 8080 in the text box. 

 Note:  
In a production environment, you can choose any unused port or leave the default. We 
recommend that you choose a number that is easy to remember. 

16. Click Next. 
17. On the Completing the SharePoint Products Configuration Wizard page, click Next. 
18. On the Configuration Successful page, click Finish. 

Once SharePoint Server 2010 configuration has been completed, the SharePoint Central 
Administration Web site opens. 

19. On the Help Make SharePoint Better page, select the No, I don’t wish to participate option, and 
then click OK. 

 Note:  
Because this is an isolated test environment, this system will be unable to upload error 
reports. 



 

20. On the Configure your SharePoint farm page, click Cancel to cancel the farm configuration wizard. 
When SharePoint Server 2010 configuration has been completed, the next step is to create a top-level 
Web site. 

Configure the top-level Web site 
A Web application is required to host the top-level web site. Perform the following procedure to create a 
Web application. 

To create a Web application 
1. In Central Administration, in the Application Management section, click Manage Web 

applications. 

2. On the toolbar, click New. 

3. On the Create New Web Application page, keep the default values, and then click OK. 

4. When the Web application has been created, click OK. 
The next step is to create a top-level Web site and give users Read permission to that site. 

 Note:  
In a production environment you should carefully consider which users should be given 
permissions to a SharePoint site and at what level. In this case, we are granting Read 
permission to all users on the top-level site, and we will grant additional permissions to specific 
users on the Business Intelligence Center that we will be creating in a later lab. 

Use the following procedure to create the top-level site. 

To create a top-level Web site 
1. On the Central Administration home page, in the Application Management section, click Create 

site collections. 

2. Confirm that Web Application is set to http://contoso-appsrv/. 
3. Type Contoso in the Title box. 

4. In the Primary Site Collection Administrator section, type FarmAdmin. 

5. Click OK. 
Now that the top-level site has been created, we will grant users access to it. Use the following 
procedure to grant users Read access to the site. 

To set Read permission on the top-level Web site 
1. Navigate to the root site (http://contoso-appsrv). 

2. Click Site Actions. 

3. Click Site Permissions. 

4. Click Grant Permissions. 

5. In the Users/Groups box, type NT AUTHORITY\Authenticated Users. 

6. Under Give Permission, select Contoso Visitors [Read]. 
7. Click OK. 
The next step is to configure the Secure Store Service. See the next article, Configure Secure Store 
Service for a BI test environment. 

http://contoso-appsrv/
http://contoso-appsrv
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Configure Secure Store Service for a BI test 
environment 
Published: May 26, 2011 

 Important:  
This article is part of the baseline setup for the Configuring a BI infrastructure: Hands-on labs 
series. To complete the steps in this article, you must first have completed Install and configure 
SharePoint Server 2010 for a BI test environment. 

In this article we deploy Secure Store Service. Secure Store provides a means of storing encrypted 
credentials for use in accessing data sources. It is used by Excel Services, Visio Services, and 
PerformancePoint Services to provide data refresh for data-connected reports, dashboards, and web 
drawings. 
In a production environment, correct deployment of Secure Store requires careful planning. For 
information about how to plan and deploy Secure Store in your production environment, see Plan the 
Secure Store service (SharePoint Server 2010) and Configure the Secure Store Service (SharePoint 
Server 2010). 

Video demonstration 
This video shows how to deploy the Secure Store Service for use in these labs. 
  

 Running time: 5:05 

  Watch the video. 

  For an optimal viewing experience, 
download the video. 
Right-click the link, and then click Save Target As 
to download a copy. Clicking the link opens a 
.wmv file in the default video viewer for full-
resolution viewing. 

  

Deploy the Secure Store Service 
In this lab, we will deploy the Secure Store Service for use in the later labs in this series. This includes 
the following tasks: 

• Creating an Active Directory account to run the Secure Store Service application pool 

• Registering that account as a managed account in Microsoft SharePoint Server 2010 

• Starting Secure Store Service on an application server in the farm 
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• Creating a Secure Store Service service application 

• Generating an encryption key 
The first step is to create an Active Directory account for the Secure Store Service application pool. Use 
the following procedure to create the account. 

To create an account for the application pool 
1. Log in to Contoso-DC by using the Contoso\administrator account. 

2. On the Contoso-DC virtual machine, click Start, click Administrative Tools, and then click Active 
Directory Users and Computers. 

3. Expand the contoso.local node. 

4. Right-click Users, click New, and then click User. 
5. In the Full name text box and the User logon name text box, type SecStrAcct. 
6. Click Next. 
7. In the Password and Confirm password text boxes, type a password for the account. 

8. Clear the User must change password at next logon check box. 

9. Select the Password never expires check box. 

10. Click Next. 
11. Click Finish. 

12. Log off Contoso-DC. 
Before the account can be used to run a SharePoint Server 2010 application pool, it must be registered 
as a managed account. Use the following procedure to register the managed account. 

To register a managed account 
1. Log in to Contoso-AppSrv by using the Contoso\FarmAdmin account. 

2. Click Start, click All Programs, click Microsoft SharePoint 2010 Products, and then click 
SharePoint 2010 Central Administration. 

3. On the Central Administration home page, in the left navigation, click Security. 

4. On the Security page, under General Security, click Configure managed accounts. 

5. On the Managed Accounts page, click Register Managed Account. 
6. In the User name text box, type Contoso\SecStrAcct. 
7. In the Password text box, type the password for the Contoso\SecStrAcct account. 

8. Click OK. 
In order for Secure Store to work, you must start Secure Store Service on at least one application 
server in the farm.  

 Note:  
In a production environment we recommend that you run Secure Store Service in a separate 
application pool that is not used for any other service. 

In the case of this lab, Contoso-AppSrv is the only application server in the farm, so we start the service 
on that server. Use the following procedure to start Secure Store Service. 

To start Secure Store Service 



 

1. On the Central Administration home page, in the System Settings section, click Manage services 
on server. 

2. Above the Service list, click the Server drop-down list, and then click Change Server. 
Note that the application server, Contoso-AppSrv, is listed together with Contoso-SQL. In a farm 
with multiple application servers, you would use this dialog box to select the server where you want 
to run Secure Store Service, and then start the service as shown later in this procedure. 

3. Click CONTOSO-APPSRV. 

4. In the Service list, click Start next to Secure Store Service. 
Once the service is running, the next step is to create a Secure Store Service service application. Use 
the following procedure to create the service application. 

To create a Secure Store Service service application 
1. On the Central Administration home page, in the Application Management section, click Manage 

service applications. 

2. On the Manage Service Applications page, click New, and then click Secure Store Service. 

3. In the Service Application Name text box, type Secure Store Service. 

4. Leave the default database settings. 

 Note:  
In a production environment we recommend that you use a separate instance of SQL 
Server for the Secure Store database. 

5. Select the Create new application pool option and in the Application pool name text box, type 
SecureStoreAppPool. 

6. Under Select a security account for this application pool, select the Configurable option, and 
from the drop-down list, select Contoso\SecStrAcct. 

7. Click OK. 

8. When the Secure Store Service service application has been successfully created, click OK. 
Before you can use Secure Store, you must first generate an encryption key. Use the following 
procedure to generate the key. 

To generate a key 
1. On the Central Administration home page, in the Application Management section, click Manage 

service applications. 

2. Click the Secure Store Service service application link. 

3. On the Secure Store Service Application page, in the ribbon, click Generate New Key. 

4. Type and confirm a pass phrase for the key, and then click OK. 
Now that Secure Store configuration is complete, the next step is to create a Business Intelligence 
Center. See the next lab, Configure a Business Intelligence Center for a test environment. 
  



 

 

Configure a Business Intelligence Center for a 
test environment 
Published: May 26, 2011 

 Important:  
This article is part of the baseline setup for the Configuring a BI infrastructure: Hands-on labs 
series. To complete the steps in this article, you must first have completed Configure Secure 
Store Service for a BI test environment. 

At this point, you have installed and configured Microsoft SharePoint Server 2010 but have not enabled 
certain services, such as Excel Services in Microsoft SharePoint Server 2010 or PerformancePoint 
Services in Microsoft SharePoint Server 2010. Those services enable robust business intelligence 
capabilities in SharePoint Server. However by using the baseline SharePoint Server environment that 
you previously configured, you do have certain capabilities that are available to you. For example, you 
can set up a Business Intelligence Center. 
The Business Intelligence Center gives you a central location to store items, such as status indicators, 
reports, and dashboards. When you enable Excel Services and PerformancePoint Services, you will 
already have a location to store reports and dashboard content.  

Video demonstration 
This video shows how to set up a Business Intelligence Center. 
  

 Running time: 6:27 

  Watch the video. 

  For an optimal viewing experience, 
download the video. 
Right-click the link, and then click Save Target As 
to download a copy. Clicking the link opens a 
.wmv file in the default video viewer for full-
resolution viewing. 

  

Configuring a Business Intelligence Center 
When you create and configure a Business Intelligence Center, you create a new site collection and 
select the Business Intelligence Center site template. The Business Intelligence Center is a top-level 
site on Contoso-AppSrv. 

To create a Business Intelligence Center 
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1. Log in to Contoso-AppSrv using the Contoso\FarmAdmin account. 

2. Click Start, click All Programs, click Microsoft SharePoint 2010 Products, and then click 
SharePoint 2010 Central Administration. 

3. In Central Administration, in the Application Management section, click Create site collections. 

4. In the Title and Description section, in the Title box, type BI Center. 
5. In the Web Site Address section, type BICenter in the box.  

Thus, the complete URL for this site collection is http://contoso-appsrv/sites/bicenter. 

6. In the Template Selection section, click the Enterprise tab, and then click Business Intelligence 
Center. 

7. In the Primary Site Collection Administrator section, type FarmAdmin. 

8. Click OK. 

9. When the top-level site (Business Intelligence Center) is successfully created, click OK. 
The next step is to assign user permissions by using the accounts we set up in Set up accounts for a BI 
test environment. We will assign permissions for the Business Intelligence Center as listed in the 
following table: 
  

Account Permissions 

Contoso\BICenterRead Read 
Read permissions enable 
users to view information in the 
Business Intelligence Center. 

Contoso\BICenterContribute Contribute 
Contribute permissions enable 
users to view and create items, 
such as reports, and save them 
to this site.  

Contoso\BICenterDesign Design 
Design permissions enable 
users to view, create, and 
publish items that include 
dashboards. 

Contoso\BICenterFullControl Full Control 
Full Control permissions 
enable users to view, create, 
and publish dashboard content, 
and to view or edit user 
permissions 

  
First, we will assign Read permissions to the Contoso\BICenterRead group. 

To set Read permissions on the Business Intelligence Center 
1. Navigate to the Business Intelligence Center (http://contoso-appsrv/sites/bicenter). 

http://contoso-appsrv/sites/bicenter
http://contoso-appsrv/sites/bicenter


 

2. Click Site Actions. 

3. Click Site Permissions. 

4. Click Grant Permissions. 

5. In the Users/Groups box, type Contoso\BICenterRead. 

6. Under Grant Permission, select BICenter Visitors [Read]. 
7. Click OK. Keep the Permissions: BICenter page open. 
Next, we will assign Contribute permissions to the Contoso\BICenterContribute group. 

To set Contribute permissions on the Business Intelligence Center 
1. In the Permissions: BICenter page, click Grant Permissions. 

2. In the Users/Groups box, type Contoso\BICenterContribute. 

3. Under Grant Permission, select BICenter Members [Contribute]. 
4. Click OK. Keep the Permissions: BICenter page open. 
The next step is to assign Design permissions to the Contoso\BICenterDesign group. 

To set Design permissions on the Business Intelligence Center 
1. In the Permissions: BICenter page, click Grant Permissions. 

2. In the Users/Groups box, type Contoso\BICenterDesign. 

3. Under Grant Permission, select Designers [Design, Limited Access]. 
4. Click OK. Keep the Permissions: BICenter page open. 
Finally, we will assign Full Control permissions to the Contoso\BICenterFullControl group. 

To set Full Control permissions on the Business Intelligence Center 
1. In the Permissions: BICenter page, click Grant Permissions. 

2. In the Users/Groups box, type Contoso\BICenterFullControl. 
3. Under Grant Permission, select BICenter Owners [Full Control]. 
4. Click OK. 

 Note:  
You will be unable to create and use some kinds of Web Parts in the Business Intelligence 
Center until Excel Services and PerformancePoint Services are enabled. For example, you 
cannot view or use Excel Services samples or PerformancePoint functionality.  

Although we do not cover this in the labs, you can now use the Business Intelligence Center to create 
Web Part Pages, status indicators, and status lists. For more information, see Getting started with 
SharePoint status indicators. 

Adding links to the Quick Launch 
After you have created and configured the Business Intelligence Center, your next step is to add links to 
the Quick Launch. In the Business Intelligence Center, we will add a Documents library link and a link to 
the main team site. Then, in the main team site, we will add a link to the Business Intelligence Center. 
In the Business Intelligence Center, the Documents library will contain reports and files, such as Excel 
Services workbooks, Visio Services files, and more. The Documents library for the Business 
Intelligence Center already exists. It was created automatically when we created the Business 
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Intelligence Center. We only have to add the Documents library on the Business Intelligence Center 
Quick Launch, and then add a link to the main team site. 

To add the Documents library and a link to the Quick Launch in the Business 
Intelligence Center 
1. In the Business Intelligence Center, click Site Actions, and then click View All Site Content. 
2. Right-click Documents, and then click Copy shortcut. 
3. In the Business Intelligence Center, click Site Actions, and then click Site Settings. 

4. Under Look and Feel, click Navigation. 

5. In the Navigation Editing and Sorting section, click Current Navigation, and then click Add 
Link. 

6. In the dialog box that opens, type Documents in the Title box, paste the link that you copied in 
Step 2, and then click OK to close the dialog box. (Do not close the navigation settings yet.) 

7. In the Navigation Editing and Sorting section, select Documents, and then click Move Up until 
Documents is the first item listed under Current Navigation.  

8. In the Navigation Editing and Sorting section, click Global Navigation, and then click Add Link. 

9. In the Title box, type Contoso.  

10. In the URL box, type http://contoso-appsrv, and then click OK. 

11. Click OK to close navigation settings. Verify that Documents appears at the top of the list in the 
Quick Launch. 

To make it easier for site users to locate the Business Intelligence Center, you can add a link on the 
main team site Quick Launch.  

To add a link on the main team site Quick Launch 
1. Browse to the main team site (http://contoso-appsrv/). 

2. Click Site Actions, and then click Site Settings. 

3. Under Look and Feel, click Quick Launch. 

4. Click New Navigation Link. 

5. In the URL section, in the Type the Web address box, type http://contoso-appsrv/sites/bicenter. 
6. In the Type the description box, type Business Intelligence Center. 
7. Click OK. 

Next steps 
Now that you have finished setting up your baseline test environment, you can choose to configure 
additional services. For more information, see any of the following resources: 

• Configure Excel Services for a BI test environment 

• Configure Visio Services for a BI test environment 

• Configure PerformancePoint Services for a BI test environment 

• Enable Reporting Services in an integrated SharePoint Server BI test environment 

• Configure Access Services for a BI test environment 

http://technet.microsoft.com/library/96a60ebb-6bc7-44f9-b7a0-137e17d4a0b9(Office.14).aspx�
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Concepts 
Create a baseline environment for a BI test environment 
  



 

 

Configure Excel Services for a BI test 
environment 
Published: May 26, 2011 

 Important:  
This article is part of the Configuring a BI infrastructure: Hands-on labs series. To complete the 
steps in this article, you must first have completed: 

• All steps in the Create a baseline environment for a BI test environment series of articles. 
Excel Services in Microsoft SharePoint Server 2010 is a service application that lets users share and 
view Microsoft Excel workbooks. The service also enables administrators to specify permission settings 
in Microsoft SharePoint Server 2010 to control what users can see or do with each workbook. 
Configuring Excel Services consists of three steps: 

• Deploying Excel Services on the SharePoint Server 2010 farm 

• Configuring trusted file locations and trusted data connection libraries 

• Configuring data access for authors of Excel workbooks 

Deploy Excel Services 
Deploying Excel Services consists of the following steps: 

• Creating an Active Directory account for the application pool under which the Excel Services 
service application will run 

• Registering that account as a managed account in SharePoint Server 2010 

• Starting the Excel Calculation Services service 

• Creating an Excel Services service application 
The first step in deploying Excel Services is to create an account in the Active Directory directory 
service to run the application pool for the Excel Services service application. Use the following 
procedure to create the account. 

To create an account for the application pool 
1. Log on to Contoso-DC using the Contoso\administrator account. 

2. On the Contoso-DC virtual machine, click Start, click Administrative Tools, and then click Active 
Directory Users and Computers. 

3. Expand the contoso.local node. 

4. Right-click Users, click New, and then click User. 
5. In the Full name box and the User logon name box, type ExcelAppPool. 
6. Click Next. 
7. In the Password and Confirm password boxes, type a password for the account. 

8. Clear the User must change password at next logon check box. 



 

9. Select the Password never expires check box. 

10. Click Next. 
11. Click Finish. 

12. Log off Contoso-DC. 
Once you have created the account, it must be registered as a managed account in SharePoint Server 
2010. Doing so makes the account available to service applications when you create them. Use the 
following procedure to register the managed account. 

To register a managed account 
1. Log in to Contoso-AppSrv using the Contoso\FarmAdmin account. 

2. Click Start, click All Programs, click Microsoft SharePoint 2010 Products, and then click 
SharePoint 2010 Central Administration. 

3. On the SharePoint Central Administration Web site home page, in the left navigation, click 
Security. 

4. On the Security page, under General Security, click Configure managed accounts. 

5. On the Managed Accounts page, click Register Managed Account. 
6. In the User name box, type Contoso\ExcelAppPool. 
7. In the Password box, type the password for the Contoso\ExcelAppPool account. 

8. Click OK. 
By default, the application pool account does not have the required access to the SharePoint content 
database. Access to this database is required for Excel Services. Use the following procedure to grant 
the required database access to the application pool account.  

To grant content database access to the managed account 
1. On Contoso-AppSrv, click Start, click All Programs, click Microsoft SharePoint 2010 Products, 

right-click SharePoint 2010 Management Shell, and then click Run as Administrator. 
2. At the Windows PowerShell Command Prompt, type the following (press Enter after each line): 

$w = Get-SPWebApplication -identity http://contoso-appsrv 
$w.GrantAccessToProcessIdentity("Contoso\ExcelAppPool") 

Once you have granted database access to the application pool account, you must start the Excel 
Calculation Services. This is the SharePoint Server 2010 service that performs all processing and 
activities associated with Excel Services. 
You must start this service on at least one application server. In a production environment, you would 
choose a server or servers on which to run the service, depending on your capacity requirements. 
Use the following procedure to start the Excel Calculation Services service. 

To start the Excel Calculation Services service 
1. On the Central Administration home page, in the System Settings section, click Manage services 

on server. 
2. Above the Service list, click the Server drop-down, and then click Change Server. 

Note that the application server, Contoso-AppSrv, is listed together with Contoso-SQL. In a farm 
with multiple application servers, you would use this dialog box to select the server where you want 
to run Secure Store Service, and then start the service as shown later in this article. 

3. Click CONTOSO-APPSRV. 

http://contoso-appsrv


 

4. In the Service list, click Start next to Excel Calculation Services. 
Once the service is started, you must create an Excel Services service application. Use the following 
procedure to create the service application. 

To create an Excel Services service application 
1. On the Central Administration home page, under Application Management, click Manage service 

applications. 

2. On the Manage Service Applications page, click New, and then click Excel Services Application. 

3. In the Name section, type Excel Services in the text box. 

4. Select the Create new application pool option and type ExcelServicesAppPool in the text box. 

5. Select the Configurable option, and from the drop-down list, select CONTOSO\excelapppool. 
6. Click OK. 

Configure trusted file locations and trusted data 
connection libraries 
In Configure a Business Intelligence Center for a test environment, we created a Business Intelligence 
Center which includes a document library and a data connection library. In order for data access to 
function, Excel Services must be configured to trust these libraries.  
Use the following procedure to create a trusted file location for the document library in the Business 
Intelligence Center. 

To create a trusted file location 
1. On the Central Administration home page, under Application Management, click Manage 

services applications. 

2. In the list of service applications, click Excel Services. 

3. Click Trusted File Locations. 

4. On the Trusted File Locations page, click Add Trusted File Location. 

5. In the Location section: 

a) Type http://Contoso-AppSrv/sites/BICenter/Documents in the Address text box. 

b) Select the Children trusted check box. 

6. In the External Data section: 

a) Under Allow External Data, select the Trusted data connection libraries and embedded 
option. 

b) In the Automatic refresh and Manual refresh text boxes, type 0. 

 Note:  
In a production environment, you would not typically set these values to 0. (Setting the cache 
values to 0 can cause additional resource utilization on the server.) However, in this series of 
labs, we are testing data refresh for data-connected workbooks, and setting the cache settings 
to 0 enables us to see data refresh results immediately. 

7. Click OK. 

http://Contoso-AppSrv/sites/BICenter/Documents


 

By creating a trusted file location, we can now publish data-connected workbooks with embedded data 
connections. However, for Excel Services to correctly render data-connected workbooks with external 
data connections, we must create a trusted data connection library. 

To create a trusted data connection library 
1. On the Central Administration home page, in the Application Management section, click Manage 

service applications. 

2. In the list of service applications, click Excel Services. 

3. Click Trusted Data Connection Libraries. 

4. On the Trusted Data Connection Libraries page, click Add Trusted Data Connection Library. 

5. In the Address box, typehttp://Contoso-
AppSrv/sites/BICenter/Data%20Connections%20for%20PerformancePoint. 

6. Click OK. 
When you have completed all of the previous procedures, Excel Services configuration is complete. 
The next step is to configure data access for the users who will create data-connected Excel 
workbooks. 

Configure Excel client data access 
In the following Excel Services labs, we will be configuring data refresh for Excel workbooks by using 
Secure Store Service. However, you should know that there are differences in the way that Excel 
Services and the Excel client application authenticate with data sources. 
Although Excel Services can use Secure Store Service to authenticate with a data source when 
rendering a data-connected workbook, Microsoft Excel does not use Secure Store for data 
authentication. Excel requires that workbook authors have direct database access in order to access 
external data from the workbook. 
In this case, we will create an Active Directory group to contain our workbook authors, and then create 
a SQL Server logon for that Active Directory group. We will then grant db_datareader access for this 
group to the ContosoRetailDW database which we will use in successive Excel Services labs. 

To create an Active Directory group 
1. Log on to Contoso-DC by using the Contoso\administrator account. 

2. On the Contoso-DC virtual machine, click Start, click Administrative Tools, and then click Active 
Directory Users and Computers. 

3. Expand the contoso.local node. 

4. Right-click Users, click New, and then click Group. 

5. In the Group Name box, type ExcelWorkbookAuthors, and then click OK. 
Next, we need to add users to the group. In this case, we will add the user Susan Burk to the group 
because Susan Burk has Contribute access to the Business Intelligence Center where we will publish 
our data-connected workbooks in successive Excel Services labs. 

 Note:  
Although we are only adding a single user to the group in this lab, in a production scenario you 
would add all the workbook authors to the group. (Using a group provides easier administration 
than adding individual logons for each user.) Depending on how your data is organized in your 
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production environment, you may want to use multiple groups if different sets of users need 
access to different databases. 

To populate the ExcelWorkbookAuthors Active Directory group 
1. In Active Directory Users and Computers, double-click the ExcelWorkbookAuthors group. 

2. On the Members tab, click Add. 

3. In the Enter object names to select box, type Contoso\Susan.Burk, and then click OK. 

4. Verify that Susan Burk appears in the Members list, and then click OK. 
Now that the Susan Burk account has been added to the ExcelWorkbookAuthors group, the next step is 
to create a SQL Server logon for that group and grant that logon Read access to the ContosoRetailDW 
database. 

To create a SQL Server logon 
1. Log on to Contoso-SQL by using the Contoso\SQLAdmin account. 

2. Click Start, click All Programs, click Microsoft SQL Server 2008 R2, and then click SQL Server 
Management Studio. 

3. Connect to the Database Engine. 

4. Expand the Security node. 

5. Right-click Logins, and then click New Login. 

6. On the Login – New page, click Search. 

7. On the Select User or Group dialog box, click Object Types. 

8. On the Object Types dialog box, select the Groups check box, and then click OK. 

9. On the Select User or Group dialog box, in the Enter the object name to select box, type 
Contoso\ExcelWorkbookAuthors, and then click OK. 

10. In the pane on the left side, click User Mapping. 

11. Under Users mapped to this login, select the Map check box for the ContosoRetailDW 
database. 

12. Under Database role membership for: ContosoRetailDW, select the db_datareader check box. 

13. Click OK. 
When you have completed all of the previous procedures, Excel Services will be operational and ready 
to use. The next step is to configure security access to your data sources. The following labs cover how 
to configure security access by using Secure Store Service: 

• Configure the Excel Services unattended service account for a BI test environment 

• Configure Excel Services data access by using embedded data connections 

• Configure Excel Services data access by using external data connections in a BI test environment 
  



 

 

Configure the Excel Services unattended 
service account for a BI test environment 
Published: May 26, 2011 

 Important:  
This article is part of the Configuring a BI infrastructure: Hands-on labs series. To complete the 
steps in this article, you must first have completed: 

• All steps in the Create a baseline environment for a BI test environment series of articles. 

• All steps in Configure Excel Services for a BI test environment 
Excel Services in Microsoft SharePoint Server 2010 provides three methods of using Secure Store to 
refresh the external data source in a workbook: 

• The unattended service account 

• A data connection embedded in the workbook 

• A data connection through an Office Data Connection (ODC) file 
This lab covers the unattended service account option. For more information about how to use an 
embedded connection, see Configure Excel Services data access by using embedded data 
connections. For more information about how to use an ODC file, see Configure Excel Services data 
access by using external data connections in a BI test environment. 
Using the unattended service account involves configuring an Active Directory account access to your 
data, storing the credentials for this account in Secure Store, and configuring Excel Services to use this 
account when it needs to refresh the data in workbook. 
The following steps are required to configure the unattended service account in Excel Services. 

• Configure a data access account 

• Configure the Secure Store Service 

• Configure the Excel Services Global Settings 
In this lab, we will also create a sample PivotTable report in Microsoft Excel that uses the 
ContosoRetailDW database and publish it to the Business Intelligence Center to confirm that data 
refresh is working. 

Configure a data access account 
When you configure the unattended service account, you have to grant the account access to the data 
source to which your Excel Services account will be connected. The unattended service account 
requires an Active Directory account for data access. Use the following procedure to create an Active 
Directory account for data access. 

To create an Active Directory account for data access 
1. Log on to Contoso-DC as Contoso\Administrator. 

2. Click Start, click Administrative Tools, and then click Active Directory Users and Computers. 

3. Expand the contoso.local node. 



 

4. Right-click Users, click New, and then click User. 
5. In the Full name and User logon name boxes, type ExcelUnattended. 

6. Click Next. 
7. Type and confirm a password for the account. 

8. Clear the User must change password at next logon check box. 

9. Select the Password never expires check box. 

10. Click Next, and then click Finish. 
Once the account has been created, the next step is to grant that account Read access to the required 
data. In a production scenario, you would grant access to whatever data source that you need to 
access from your Excel 2010 workbook. Use the following procedure to create a SQL Server logon and 
grant that logon Data Reader access to the ContosoRetailDW table. 

To create a SQL Server logon 
1. Log on to Contoso-SQL as Contoso\SQLAdmin. 

2. Click Start, click All Programs, click Microsoft SQL Server 2008 R2, and then click SQL Server 
Management Studio. 

3. On the Connect to Server dialog box, select Database Engine as the Server type, type 
Contoso-SQL in the Server name box, and then click Connect. 

4. In Object Explorer, expand Security. 

5. Right-click Logins, and then click New Login. 

6. In the Login name box, type Contoso\ExcelUnattended. 

7. Under Select a page, click User Mapping. 

8. Select the Map check box for the ContosoRetailDW database, and then, under Database role 
membership for: ContosoRetailDW, select the db_datareader check box. 

9. Click OK. 
With the account created and granted the appropriate data access, we can now configure Secure Store 
Service. 

Configure Secure Store Service 
Secure Store Service uses a target application to define connection parameters and authorized users. 
The unattended service account is generally considered a catch-all account that is used for general 
data access, so usually all users are granted access to the unattended service account through the 
target application. 
In order to grant all users data access through the unattended service account, the account that is 
running the Excel Services application pool is added as a Member of the Secure Store target 
application. In Configure Excel Services for a BI test environment, we created the 
Contoso\ExcelAppPool account to run the Excel Services application pool. However, in a production 
environment you may not know what this account is, so we will describe the steps to determine the 
application pool account. 

To find the Windows identity assigned to the Excel Services application pool 
1. Log in to Contoso-AppSrv using the Contoso\FarmAdmin account. 



 

2. Click Start, click All Programs, click Microsoft SharePoint 2010 Products, and then click 
SharePoint 2010 Central Administration. 

3. On the SharePoint Central Administration Web site home page, click Security. 

4. On the Security page, under General Security, click Configure service accounts. 

5. On the Service Account page, in the Credential Management section, from the drop-down list, 
select the application pool that runs Excel Services Application (in this case, Service Application 
Pool - ExcelServicesAppPool).  
When this option is selected, the name of the Excel Services Application appears in the box 
underneath the drop-down list (in this case, Excel Services). 

6. Note that Contoso\ExcelAppPool is displayed in the Select an account for this component 
drop-down list. This is the Windows identity that you will need for the Members list when you 
configure the unattended service account in Secure Store. 

7. Click Cancel 
Once you have determined which account is being used to run the application pool for the Excel 
Services service application, the next step is to create a target application in Secure Store for the 
unattended service account. Use the following procedure to create the target application. 

To create a target application for the unattended service account 
1. On the Central Administration home page, under Application Management, click Manage service 

applications. 

2. Click the Secure Store Service service application. 

3. On the ribbon, click New. 

4. In the Target Application ID box, type ExcelServicesUnattended. 

5. In the Display Name box, type ExcelServicesUnattended. 

6. In the Contact E-mail box, type farmadmin@contoso.local. 

 Note:  
Although e-mail notifications are not configured in this environment, Contact E-mail is a 
required field. 

7. In the Target Application Type drop-down list, select Group. 

8. Click Next. 
9. Leave the default credential fields, and then click Next. 
10. On the Specify the membership settings page: 

• In the Target Application Administrators box, type Contoso\FarmAdmin. 

• In the Members box, because we will use the target application to store credentials for the 
unattended service account, type the Excel Services application pool account that we located in 
the previous procedure (Contoso\ExcelAppPool). 

11. Click OK. 
Once the target application has been created, you must specify which credentials should be used by it. 
The target application credentials are those to which data access has been granted — in our case, the 
Contoso\ExcelUnattended account to which we granted db_datareader access to the ContosoRetailDW 
database. 
Use the following procedure to set the credentials for the target application. 



 

To set the credentials for the target application 
1. On the Secure Store Service Application page, in the Target Application ID column, point to 

ExcelServicesUnattended, click the arrow that appears, and then click Set Credentials. 

2. In the Windows User Name box, type Contoso\ExcelUnattended. 

3. Type and confirm the password for the Contoso\ExcelUnattended account. 

4. Click OK. 
With the credentials set for the target application, the Secure Store Service configuration for the 
unattended service account is complete. The next step is to configure Excel Services to use this target 
application for the unattended service account. 

Configure Excel Services 
The unattended service account configuration is part of the Excel Services Global Settings. Use the 
following procedure to configure the unattended service account in Excel Services. 

To configure Excel Services Global Settings 
1. On the Central Administration home page, in the Application Management section, click Manage 

service applications. 

2. On the Manage Service Applications page, click Excel Services. 

3. On the Manage the Excel Services page, click Global Settings. 

4. On the Excel Services Settings page, in the External Data section, in the Application ID box, type 
ExcelServicesUnattended. 

5. Click OK. 
With the Excel Services Global Settings configured, setup of the unattended service account is 
complete. In the next section, we create an Excel workbook with external data and publish it to the 
SharePoint document library in the Business Intelligence Center. We then test data refresh by using the 
unattended service account.  

Publishing a workbook with an external data source 
To test the configuration of the unattended service account, we must first create a workbook with an 
external data connection. Use the following procedure to create the workbook. 

To create a workbook with an external data connection 
1. Log on to Contoso-Client by using the Contoso\Susan.Burk account. 

2. Click Start, click All Programs, click Microsoft Office, and then click Microsoft Excel 2010. 

3. On the Data tab, in the Get External Data group, click From Other Sources, and then click From 
SQL Server. This starts the Data Connection Wizard, which has three pages. 

4. In the Server name box, type Contoso-SQL. 

5. Under Log on credentials, click the Use Windows Authentication option, and then click Next to 
go to page 2 of the Data Connection Wizard. 

6. In the Select the database that contains the data you want section, select ContosoRetailDW. 
In the Connect to a specific table section, select DimStore, and then click Next. 

7. On the Save Data Connection File and Finish page, click Finish. 



 

 Note:  
If you are prompted to overwrite the connection file, click Yes. 

8. On the Import Data dialog box, select the PivotTable Report option, and then click OK. 

9. In the pane on the right side, in the Pivot Table Field List: 
a) Select the SellingAreaSize check box. 

b) Select the StoreType check box. 
Leave the Excel workbook open for the next procedure. 
We now have a data-connected workbook that contains a report. However, we must modify the Excel 
2010 settings before we publish the workbook to the document library. By default, the Excel 2010 
settings are configured to use Windows authentication, which is not the correct setting for using the 
unattended service account. Use the following procedure to modify the Excel 2010 authentication 
settings in the workbook that we just created. 

To configure Excel Services authentication settings 
1. In the Excel workbook, on the Data tab, click Connections. 

2. On the Workbook Connections dialog box, click Properties. 

3. On the Connection Properties dialog box, on the Definition tab, click Authentication Settings. 

4. On the Excel Services Authentication Settings dialog box, select the None option, and then click 
OK. 

5. On the Connection Properties dialog box, click OK. 

 Note:  
If you see a warning that the link to the external connection file will be removed, click Yes. 
(Although Excel requires you to save a connection file, that file is not required by Excel 
Services for authentication.) 

6. On the Workbook Connections dialog box, click Close. 
Leave the Excel workbook open for the next procedure. 
Now that we have set the Excel Services authentication settings, the next step is to publish the 
workbook to the document library in the Business Intelligence Center and confirm that data refresh is 
working correctly. 

To publish a workbook to a SharePoint document library 
1. In the Excel workbook, click File, click Save & Send, and then click Save to SharePoint. 
2. In the Locations section, click Browse for a location, and then click Save As. 

3. On the Save As dialog box, in the URL box, type http://Contoso-AppSrv/sites/BICenter, and 
then press Enter. 

 Note:  
It may take several moments for the file list to refresh. 

4. In the Document Libraries list, double-click Documents. 

5. In the File name box, type SellingAreas.xlsx. 

6. Ensure that the Open with Excel in the browser check box is selected, and then click Save. 
Once the workbook has been saved to the document library, it will automatically load in a browser. The 
next step is to confirm that data refresh is working correctly. 

http://Contoso-AppSrv/sites/BICenter


 

Leave the browser that displays the SellingAreas.xlsx workbook open for the procedures in the next 
section. 

Testing data refresh 
To confirm that data refresh works with the unattended service account, we will follow these steps: 

• Refresh the data currently displayed in the browser on Contoso-Client 

• Change a value in the ContosoRetailDW database 

• Refresh the data displayed in the browser on Contoso-Client again and confirm that the new 
information is displayed 

First, we will refresh the existing data. Use the following procedure to refresh the data in the browser. 

To refresh a data-connected workbook by using Excel Services 
1. In the browser, on the Data drop-down list, click Refresh All Connections. 

 Note:  
If a warning message appears, click OK. 

If the unattended service account is configured correctly, the data will refresh without error, although we 
will not see any changes in data values at this point. The next step is to change a value in the 
ContosoRetailDW database and confirm that the changes appear in the workbook. 

To update data in the ContosoRetailDW database 
1. Log on to Contoso-SQL by using the Contoso\SQLAdmin account. 

2. Click Start, click All Programs, click Microsoft SQL Server 2008 R2, and then click SQL Server 
Management Studio. 

3. On the Connect to Server dialog box, select Database Engine for the Server type, and then click 
Connect. 

4. In the toolbar, click New Query. 

5. Copy the following query to the query window: 
USE [ContosoRetailDW] 
GO 
UPDATE dbo.DimStore set dbo.DimStore.SellingAreaSize = 500 where dbo.DimStore.StoreType = 
'Catalog' 
GO 
 

6. In the toolbar, click Execute. 

7. Return to Contoso-Client where the SellingArea.xlsx workbook is displayed. 
Return to the Contoso-Client virtual machine, where SellingAreas.xlsx is displayed in the browser. 
Note the currently displayed number for the Catalog row in the spreadsheet. We updated this row to a 
value of 500 in the DimStore table, so the new value should appear when we refresh the workbook. 
Use the following procedure to refresh the workbook. 

 Note:  
If you see a warning that the page has expired, click OK and restart the procedure. 

To refresh a data-connected workbook by using Excel Services 



 

1. In the browser, on the Data drop-down list, click Refresh All Connections. 

 Note:  
If a warning message appears, click OK. 

The new value of 500 should now appear in the Catalog row of the report, confirming that data refresh 
through the unattended service account is working. 

 Note:  
The Excel Services cache settings affect how quickly the new results appear when you refresh 
the workbook. In the Configure Excel Services for a BI test environment lab, we set the cache 
settings to zero (0), allowing immediate refresh. In a production environment, refresh will likely 
take longer depending on how you configure the cache. 

  



 

 

Configure Excel Services data access by using 
external data connections in a BI test 
environment 
Published: May 26, 2011 

 Important:  
This article is part of the Configuring a BI infrastructure: Hands-on labs series. To complete the 
steps in this article, you must first have completed: 

• All steps in the Create a baseline environment for a BI test environment series of articles. 

• All steps in the Configure Excel Services for a BI test environment article. 
Excel Services in Microsoft SharePoint Server 2010 provides three methods of using Secure Store to 
refresh the external data source in a workbook: 

• The unattended service account 

• A data connection embedded in the workbook 

• A data connection through an Office Data Connection (ODC) file 
This lab covers the Office Data Connection file option. For more information about how to use an 
embedded connection, see Configure Excel Services data access by using embedded data 
connections. For more information about how to use the unattended service account, see Configure the 
Excel Services unattended service account for a BI test environment. 
In this lab we create a PivotTable report on Microsoft Excel 2010 that uses an external data connection 
to Microsoft SQL Server 2008 R2. Next, we explain how to save this PivotTable report on Microsoft 
SharePoint Server 2010, and then how to confirm that data refresh is working correctly. 

Configure a data access account 
When you configure data access through Secure Store, you must grant the account access to the data 
source to which your Excel Services workbook will be connected. For the purposes of this lab, we will 
continue to use the Contoso database sample data which we can use in a data-connected workbook 
that we will publish to a SharePoint document library. 

To create an Active Directory account for data access 
1. Log on to Contoso-DC as Contoso\Administrator. 

2. Click Start, click Administrative Tools, and then click Active Directory Users and Computers. 

3. Expand the contoso.local node. 

4. Right-click Users, click New, and then click User. 
5. In the Full name and User logon name boxes, type ExcelODCAccess. 

6. Click Next. 
7. Type and confirm a password for the account. 



 

8. Clear the User must change password at next logon check box. 

9. Select the Password never expires check box. 

10. Click Next, and then click Finish. 
Once the account is created, the next step is to grant that account Read access to the required data. In 
a production scenario, you would grant access to whatever data source that you have to access from 
your Excel Services workbook. In this lab we will grant access to the ContosoRetailDW database. Use 
the following procedure to create a SQL Server logon and grant that logon Data Reader access to the 
database. 

To create a SQL Server logon 
1. Log on to Contoso-SQL as Contoso\SQLAdmin. 

2. Click Start, click All Programs, click Microsoft SQL Server 2008 R2, and then click SQL Server 
Management Studio. 

3. On the Connect to Server dialog box, select Database Engine as the Server type, type 
Contoso-SQL in the Server name box, and then click Connect. 

4. In Object Explorer, expand Security. 

5. Right-click Logins, and then click New Login. 

6. In the Login name box, type Contoso\ExcelODCAccess. 

7. Under Select a page, click User Mapping. 

8. Select the Map check box for the ContosoRetailDW database, and then under Database role 
membership for: ContosoRetailDW, select the db_datareader check box. 

9. Click OK. 

Configure Secure Store 
Earlier in this lab series, we configured Secure Store Service in the Configure Secure Store Service for 
a BI test environment article. Now we must create a target application for Excel Services with a series 
of procedures. These procedures explain how to create an Active Directory group in the virtual network, 
how to create the target application in Secure Store, and finally how to assign credentials to this target 
application. 
In the Secure Store target application, we will map a specific group of users to the 
Contoso\ExcelODCAccess account that we created in the previous section. Although these users will 
never have direct access to this account, Excel Services will use this account on their behalf to refresh 
data-connected workbooks. 
To avoid the complexity of administering individual users, we will create an Active Directory group to 
contain them. 

To create an Active Directory group for user data access 
1. Log on to Contoso-DC as Contoso\Administrator. 

2. Click Start, click Administrative Tools, and then click Active Directory Users and Computers. 

3. Expand the contoso.local node. 

4. Right-click Users, click New, and then click Group. 

5. In the Group name box, type ExcelODCAccessGroup. 

6. Click OK. 



 

After the group account is created in Active Directory, we must now populate the group with user 
accounts to which we want to give data access through Secure Store. The following procedure explains 
how to do this. 

To populate the data access group 
1. In Active Directory Users and Computers, in the users list, double-click the 

ExcelODCAccessGroup group. 

2. On the Members tab, click Add. 

3. On the Select Users dialog box, type Contoso\susan.burk; Contoso\john.woods, and the click 
OK. 

4. The Members tab should now show Susan Burk and John Woods as members of the group. 

5. Click OK. 
Now that you have created Active Directory accounts for data access, you can create a target 
application for Excel Services to use with an Office Data Connection (ODC). Use the following 
procedure to create and configure the target application. 

To create a target application 
1. Log in to Contoso-AppSrv using the Contoso\FarmAdmin account. 

2. Click Start, click All Programs, click Microsoft SharePoint 2010 Products, and then click 
SharePoint 2010 Central Administration. 

3. On the SharePoint Central Administration Web site home page, in the Application Management 
section, click Manage service applications. 

4. Click the Secure Store Service service application. 

5. On the ribbon, click New. 

6. In the Target Application ID box, type ExcelServicesODC. 

7. In the Display Name box, type ExcelServicesODC. 

8. In the Contact E-mail box, type farmadmin@contoso.local. 

 Note:  
Although e-mail notifications are not configured in this environment, Contact E-mail is a 
required field. 

9. In the Target Application Type drop-down list, select Group. 

10. Click Next. 
11. Leave the default credential fields, and then click Next. 
12. On the Specify the membership settings page: 

• In the Target Application Administrators box, type Contoso\FarmAdmin. 

• In the Members box, type Contoso\ExcelODCAccessGroup. 

• Click OK. 
Once the target application has been created, the next step is to associate the data access account that 
we created (Contoso\ExcelODCAccess) with the target application. Use the following procedure to set 
the credentials for the target application. 

To set the credentials for the target application 



 

1. On the Secure Store Service Application page, in the Target Application ID column, point to 
ExcelServicesODC, click the arrow that appears, and then click Set Credentials. 

2. In the Windows User Name box, type Contoso\ExcelODCAccess. 

3. Type and confirm the password for the Contoso\ExcelODCAccess account. 

4. Click OK. 

Create and publish an ODC file 
Now that Secure Store has been configured, the next step is to create the ODC file and publish it to a 
trusted data connection library. Use the following procedure to create an ODC file that has a connection 
to the ContosoRetailDW database. 

To create and publish an ODC file 
1. Log on to the Contoso-Client virtual machine by using the Contoso\Susan.Burk account. 

2. Click Start, click All Programs, click Microsoft Office, and then click Microsoft Excel 2010. 

3. On the Data tab, click From Other Sources, and then click From SQL Server. 
4. On the Connect to Database Server page of the Data Connection Wizard, type Contoso-SQL in 

the Server name box, and then click Next. 
5. On the Select Database and Table page, select ContosoRetailDW from the drop-down list. 

6. In the list of tables, select DimProduct, and then click Next. 
7. Click Finish. 

 Note:  
If you are prompted to overwrite the ODC file on the local disk, click Yes. 

8. On the Import Data dialog box, select the PivotTable Report option, and then click OK. 

9. On the Data tab, click Connections. 

10. On the Workbook Connections dialog box, click Properties. 

11. On the Connection Properties dialog box, on the Definition tab, click Authentication Settings. 

12. On the Excel Services Authentication Settings dialog box, select the SSS option, type 
ExcelServicesODC in the SSS ID box, and then click OK. 

13. On the Connection Properties dialog box, click Export Connection File. 

14. On the File Save dialog box, in the URL box, type http://Contoso-AppSrv/sites/BICenter, and 
then press Enter. 

 Note:  
It may take several moments for the list to refresh with content from the BI Center. 

15. In the list of All Site Content, double-click Data Connections. 

16. In the File name box, type DimProductTable, and then click Save. 

17. On the Data Connections dialog box, select Office Data Connection File from the Content Type 
drop-down list, and then click OK. 

18. On the Connection Properties dialog box, click OK, and then, on the Workbook Connections 
dialog box, click Close. 

19. Exit Microsoft Excel. 

http://Contoso-AppSrv/sites/BICenter


 

 Note:  
You do not have to save the workbook. 

Remain logged on to Contoso-Client as Susan Burk for the next procedure. 
We have now successfully published an ODC file that contains a data connection to the DimProduct 
table of the ContosoRetailDW database and uses the ExcelServicesODC target application in Secure 
Store for authentication. 

Testing data refresh 
In this section we will test what we previously configured by publishing a data-connected Excel 
workbook that uses the DimProductTable.odc file that we published earlier for data connectivity. Use 
the following procedure to create and publish a pivot table. 

To create and publish a pivot table 
1. On Contoso-Client, click Start, click All Programs, click Microsoft Office, and then click 

Microsoft Excel 2010. 

2. On the Data tab, click Existing Connections. 

3. On the Existing Connections dialog box, click Browse for More. 

4. On the Select Data Source dialog box, in the URL box, type http://Contoso-
AppSrv/sites/BICenter, and then press Enter. 

 Note:  
It may take several moments for the list to refresh with content from the BI Center. 

5. In the list of All Site Content, double-click Data Connections. 

6. On the list of Data Connections, select DimProductTable, and then click Open. 

7. On the Import Data dialog box, select the PivotTable Report option, and then click OK. 

8. In the Pivot Table Field List: 
a) Drag Manufacturer to the Row Labels box. 

b) Drag ProductName to the Values box. 

9. Click File, click Save & Send, click Save to SharePoint, click Browse for a location, and then 
click Save As. 

10. On the Save As dialog box, in the URL box, type http://Contoso-AppSrv/sites/BICenter, and 
then press Enter. 

 Note:  
It may take several moments for the list to refresh with content from the BI Center. 

11. In the All Site Content list, double-click Documents. 

12. In the File name box, type ProductsPerVendor.xlsx. 

13. Confirm that the Open with Excel in the browser check box is selected, and then click Save. 
The workbook will render in the browser. Leave the browser open for the following procedures. 
To confirm that data refresh is works by using the ODC file and Secure Store, we will follow these 
steps: 

• Refresh the data currently displayed in the browser on Contoso-Client 

• Change a value in the ContosoRetailDW database 

http://Contoso-AppSrv/sites/BICenter
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• Refresh the data displayed in the browser on Contoso-Client again and confirm that the new 
information is displayed 

First, we will refresh the existing data. Use the following procedure to refresh the data in the browser. 

To refresh a data-connected workbook by using Excel Services 
1. In the browser, on the Data drop-down list, click Refresh All Connections. 

 Note:  
If a warning message appears, click OK. 

If everything is configured correctly, the data will refresh without error, although we will not see any 
changes in values at this point. The next step is to change a value in the ContosoRetailDW database 
and confirm that the changes appear in the workbook. 

To update data in the ContosoRetailDW database 
1. Log on to Contoso-SQL by using the Contoso\SQLAdmin account. 

2. Click Start, click All Programs, click Microsoft SQL Server 2008 R2, and then click SQL Server 
Management Studio. 

3. On the Connect to Server dialog box, select Database Engine for the Server type, and then click 
Connect. 

4. In the toolbar, click New Query. 

5. Copy the following query to the query window: 
USE [ContosoRetailDW] 
GO 
UPDATE dbo.DimProduct set dbo.DimProduct.Manufacturer = 'Contoso, Ltd' where 
dbo.DimProduct.Manufacturer = 'Northwind Traders' 
GO 
 

6. In the toolbar, click Execute. 

 Note:  
After the query runs, you should see (47 row(s) affected) in the Messages window. 

Return to the Contoso-Client virtual machine, where ProductPerVendor.xlsx is displayed in the browser. 
Note the currently displayed number of products provided by Northwind Traders is 47, and the number 
provided by Contoso, Ltd is 710 in the spreadsheet. We changed all the products from Northwind 
Traders to Contoso, Ltd in the DimManufacturer table, so the new value should appear when we 
refresh the workbook. Use the following procedure to refresh the workbook. 

 Note:  
If you see a warning that the page has expired, click OK and restart the procedure. 

To refresh a data-connected workbook by using Excel Services 
1. In the browser, on the Data drop-down list, click Refresh All Connections. 

 Note:  
If a warning message appears, click OK. 

Notice that Northwind Traders has now disappeared from the report and the number of products 
provided by Contoso, Ltd has changed from 710 to 757, confirming that data refresh through the ODC 
file and Secure Store is working. 



 

 Note:  
The Excel Services cache settings affect how quickly the new results appear when you refresh 
the workbook. In the Configure Excel Services for a BI test environment lab, we set the cache 
settings to zero (0), allowing immediate refresh. In a production environment, refresh will likely 
take longer depending on how you configure the cache. 

  



 

 

Configure Excel Services data access by using 
embedded data connections 
Published: May 26, 2011 

 Important:  
This article is part of the Configuring a BI infrastructure: Hands-on labs series. To complete the 
steps in this article, you must first have completed: 

• All steps in the Create a baseline environment for a BI test environment series of articles. 

• All steps in the Configure Excel Services for a BI test environment article. 
Excel Services in Microsoft SharePoint Server 2010 uses three methods of connecting to external data: 

• You can use an unattended service account. For more information, see Configure the Excel 
Services unattended service account for a BI test environment. 

• You can use an Office Data Connection (ODC) file. For more information, see Configure Excel 
Services data access by using external data connections in a BI test environment. 

• You can embed an ODC file in a workbook. This article describes how to this. 
To configure Excel Services data access to use embedded data connections, we will use the following 
process: 

1. Configure a data access account 

2. Configure the Secure Store Service application 

3. Create and publish an Excel workbook that uses an embedded data connection 

4. Verify that data updates in an Excel Services file 

Configure a data access account 
To configure Excel Services to use embedded data connections, we begin by configuring a data access 
account. We then grant this account Read access to data that is stored in SQL Server.  

 Note:  
We will be using the ContosoRetailDW dataset that we installed when we set up SQL Server. 
For more information, see Set up SQL Server for a BI test environment. 

To create an Active Directory account for data access 
1. Log into Contoso-DC using the Contoso\administrator account. 

2. Click Start, click Administrative Tools, and then click Active Directory Users and Computers. 

3. Expand the contoso.local node. 

4. Right-click Users, click New, and then click User. 
5. In the Full name and User logon name text boxes, type ExcelDataEmbed, and then click Next. 
6. Type and confirm a password for the account. 

7. Clear the User must change password at next logon check box. 



 

8. Select the Password never expires check box. 

9. Click Next, and then click Finish. 
Now that the ExcelDataEmbed account is created, the next step is to grant that account read access to 
the required data. Use the following procedure to create a SQL Server logon and grant Read access to 
the database. 

To create a SQL Server logon 
1. Log in to Contoso-SQL using the Contoso\SQLAdmin account. 

2. Click Start, click All Programs, click Microsoft SQL Server 2008 R2, and then click SQL Server 
Management Studio. 

3. On the Connect to Server dialog box, select Database Engine as the Server type, type 
Contoso-SQL in the Server name text box, and then click Connect. 

4. In Object Explorer, expand Security. 

5. Right-click Logins, and then click New Login. 
The Login – New dialog box opens. 

6. Next to the Login name text box, type Contoso\ExcelDataEmbed. 

7. In the Login – New dialog box, in the Select a page pane, click User Mapping. 
A list of databases appears. 

8. Select the Map check box for the ContosoRetailDW database, and then in the Database role 
membership for: ContosoRetailDW section, select the db_datareader check box. 

9. Click OK to close the Login – New dialog box. Notice that the Contoso\ExcelDataEmbed data 
access account is now displayed in the Logins list. 

Now that we have created a data access account, the next step is to configure the Secure Store 
Service application. 

Configure the Secure Store Service application 
To configure the Secure Store Service application, we begin by creating an Active Directory group. This 
group will be used to provide data access to Excel users who are using embedded data connections. 

To create an Active Directory group for user data access 
1. Log into Contoso-DC using the Contoso\Administrator account. 

2. Click Start, click Administrative Tools, and then click Active Directory Users and Computers. 

3. Expand the contoso.local node. 

4. Right-click Users, click New, and then click Group. 
The New Object – Group dialog box opens. 

5. In the Group name box, type ExcelDataEmbedGroup, and then click OK. 
Notice that ExcelDataEmbedGroup now appears in the list of groups and users. 

6. Double-click ExcelDataEmbedGroup to open it for editing. 

7. Click the Members tab, and then click Add. 
The Select Users, Contacts, Computers, Services Accounts, or Groups dialog box opens. 



 

8. In the Enter the object names to select box, type Contoso\susan.burk; Contoso\john.woods, 
and then click Check Names. 
The user accounts are verified and then appear as hyperlinks. 

9. Click OK to close the Select Users, Contacts, Computers, Services Accounts, or Groups dialog 
box. 

10. Click OK to close the ExcelDataEmbedGroup Properties dialog box. 
Now that we have created our Active Directory accounts, the next step is to configure the Secure Store 
Service application. We begin by creating a target application. 

To create a target application 
1. Log into Contoso-AppSrv using the Contoso\FarmAdmin account. 

2. Click Start, click All Programs, click Microsoft SharePoint 2010 Products, and then click 
SharePoint 2010 Central Administration.  

3. On the Central Administration home page, under Application Management, click Manage service 
applications. 

4. Click the Secure Store Service application. 

5. On the ribbon, click New. 

6. In the Target Application ID text box, type ExcelServicesEmbeddedData. 

7. In the Display Name text box, type Excel Services Embedded Data. 

8. In the Contact E-mail text box, type farmadmin@contoso.local. 

 Note:  
Although e-mail notifications are not configured in this environment, you must specify an 
email address in the Contact E-mail box. 

9. In the Target Application Type drop-down list, select Group, and then click Next. 
10. Keep the default credential fields, and then click Next. 
11. On the Specify the membership settings page, in the Target Application Administrators box, 

type Contoso\FarmAdmin. 

12. In the Members box, type Contoso\ExcelDataEmbedGroup, and then click OK. Do not leave the 
page yet. 

13. Position the pointer on ExcelServicesEmbeddedData, click the down arrow that appears, and 
then click Set Credentials.  
The Set Credentials for Secure Store Target Application (Group) page opens. 

14. In the Windows User Name box, type Contoso\ExcelDataEmbed. 

15. Type and confirm the password for the Contoso\ExcelDataEmbed account, and then click OK. 

16. Click OK. 
Now that we have configured Excel Services data access to use embedded data connections, the next 
step is to create and publish an Excel workbook that uses an embedded connection. We will then use 
this workbook to verify that data updates correctly in Excel Services.  



 

Create and publish an Excel workbook that uses an 
embedded data connection 
In this section, we describe how to create a PivotTable report that uses data that is stored in SQL 
Server and publish the workbook to SharePoint Server. We will then refresh the data in the workbook 
that uses the embedded connection.  

Creating a PivotTable report by using a SQL Server table 
For this report, we use a table that is stored in SQL Server.  

To create a PivotTable report by using external SQL Server data 
1. Log into Contoso-Client using the Contoso\Susan.Burk account. 

2. In Microsoft Excel 2010, on the Data tab, in the Get External Data group, click From Other 
Sources, and then click From SQL Server. The Data Connection Wizard opens. 

3. In the Server name box, type Contoso-SQL, and then click Next. 
4. Use the Select the database that contains the data that you want to select ContosoRetailDW.  

5. Select the Connect to a specific table check box, and then select DimStore. Then, click Next. 
6. In the Description box, type Contoso Stores, and then click Finish. 

The Import Data dialog box opens. 

 Note:  
If you are prompted to replace the ODC file that is located on your local computer, click 
Yes. 

7. In the Select how you want to view this data in your workbook section, click PivotTable 
Report, and then click OK. 
An empty PivotTable report opens. 

8. In the PivotTable Field List pane, drag StoreType to the Row Labels section. 

9. Drag EmployeeCount to the Values section. 
The PivotTable report updates to display a count of stores that have employees.  

10. In the Values section, click the down arrow for EmployeeCount, and then click Value Field 
Settings. 

11. In the Summarize value field by section, click Sum, and then click OK.  
Notice that the PivotTable report updates to display the total number of employees for each kind of 
store. 
Do not close the workbook. Keep it open for the next procedure. 

At this point, we have created and saved a PivotTable report in Excel. However, we have not yet 
embedded the external data connection information in the workbook. The next step is to configure and 
embed that connection. 

To embed external data connection information in an Excel workbook 
1. In Excel 2010, on the Data tab, in the Connections group, click  Connections. 

The Workbook Connections dialog box opens. 

2. Select the Contoso-sql ContosoRetailDW DimStore connection, and then click Properties.  



 

The Connection Properties dialog box opens. 

3. Select the Definition tab. 

4. In the Excel Services section, click Authentication Settings. 
The Excel Services Authentication Settings dialog box opens. 

5. Select SSS, and in the SSS ID box, type ExcelServicesEmbeddedData.  

6. Click OK to close the Excel Services Authentication Settings dialog box, and then click OK to close 
the Connection Properties dialog box. 

7. If a warning appears that states that the link to the external odc file will be removed, click Yes. 

8. In the Workbook Connections dialog box, click Close. Do not close the workbook yet. 
At this point, we have created a workbook that contains an embedded data connection. The next step is 
to publish the workbook to SharePoint Server. 

To publish the ContosoStores workbook 
1. In Excel, click the File tab, and then click Save & Send. 

2. Click Save to SharePoint. 
3. Under Locations, click Browse for a location, and then click Save As. 

The Save As dialog box opens. 

4. In the location box at the top of the window, type http://contoso-
appsrv/sites/BICenter/Documents. 

 Note:  
It might take some time for the Save As dialog box to refresh and show the site content. 

5. In the File name box, type ContosoStores.xlsx. 

6. Select the Open with Excel in the browser check box, and then click Save. 
A browser window opens and displays the ContosoStores workbook.  

At this point, we have created and published a workbook that uses an embedded data connection. The 
next and final step is to verify that the data updates correctly. 

Verify that data updates in an Excel Services file 
In this section, we verify that data in the Excel workbook updates by using the embedded connection 
correctly. We begin by viewing the ContosoStores workbook in a browser window. We modify a row in 
the SQL Server database that is used by the workbook, and then confirm that the workbook displays 
the updated data as expected. 
On the Contoso-Client computer, the ContosoStores workbook is open in a browser window. Notice 
that the PivotTable report shows the number of employees for each kind of store.  

• Catalog: 120 employees 

• Online: 340 employees 

• Reseller: 44 employees 

• Store: 10535 employees 
The next step is to modify a row of data in the table that is used by the ContosoStores workbook. We 
will change one of the Reseller stores to Store. This will change the number of employees for both the 
Reseller and Store groups. 

http://contoso-appsrv/sites/BICenter/Documents
http://contoso-appsrv/sites/BICenter/Documents


 

To update data in the ContosoRetailDW database 
1. Log into Contoso-SQL using the Contoso\SQLAdmin account. 

2. Click Start, click All Programs, click Microsoft SQL Server 2008 R2, and then click SQL Server 
Management Studio. 

3. On the Connect to Server dialog box, select Database Engine for the Server type, and then click 
Connect. 

4. In the toolbar, click New Query. 

5. Type the following query to the query window: 
USE [ContosoRetailDW] 
GO 
UPDATE dbo.DimStore set dbo.DimStore.StoreType = 'Store' where 
dbo.DimStore.StoreDescription = 'Contoso Europe Reseller' 
GO 
 

6. In the toolbar, click Execute. 
In the Messages pane, (1 row(s) affected) appears. 

Now that we have changed one of the stores from Reseller to Store, the number of employees for those 
kinds of stores should have changed, too. 
On the Contoso-Client computer, view the workbook. The PivotTable report should now show the 
following information: 

• Catalog: 120 employees 

• Online: 340 employees 

• Reseller: 32 employees 

• Store: 10547 employees 
We see that after we changed that single row of data, Reseller went from 44 employees to 32, and 
Store went from 10535 employees to 10547 employees. The store that we changed has 12 employees. 
Therefore, this is correct. We have confirmed that data is refreshing as expected in the workbook. 

Concepts 
Configure Excel Services for a BI test environment 
Configure PerformancePoint Services for a BI test environment 
Configure Visio Services for a BI test environment 
  



 

 

Configure PowerPivot for SharePoint for a BI 
test environment 
Published: September 27, 2011 
This article is part of the Configuring a BI infrastructure: Hands-on labs series. To complete the steps in 
this article, you must first have completed: 

• Create a baseline environment for a BI test environment 

• Configure Excel Services for a BI test environment 
Microsoft SQL Server PowerPivot for Microsoft SharePoint supports query processing and data refresh 
for published Excel workbooks that contain PowerPivot data. This article describes how to configure 
PowerPivot for SharePoint 2010 in a virtual environment that already has SharePoint Server 2010 and 
SQL Server 2008 R2 installed and configured.  
Configuring PowerPivot for SharePoint consists of the following steps: 

• Create a managed account for SQL Server Analysis Services 

• Deploy PowerPivot for SharePoint 

• Configure a PowerPivot service application 

• Configure data refresh for PowerPivot for SharePoint 

• Configure Secure Store service for PowerPivot for SharePoint 

• Verify that PowerPivot for SharePoint is configured correctly 

• Test data refresh 

Create a managed account for SQL Server Analysis 
Services 
To configure PowerPivot for SharePoint, you must have a service account for the SQL Server Analysis 
Services instance that is installed with PowerPivot for SharePoint. Use the following procedure to 
create an Active Directory account for Analysis Services. 

To create an Active Directory account for Analysis Services 
1. Log on to Contoso-DC as Contoso\Administrator. 

2. Click Start, click Administrative Tools, and then click Active Directory Users and Computers. 

3. Expand the contoso.local node. 

4. Right-click Users, click New, and then click User. 
5. In the Full name and User logon name boxes, type PowerPivotSSAS. 

6. Click Next. 
7. Type and confirm a password for the account. 

8. Clear the User must change password at next logon check box. 

9. Select the Password never expires check box. 



 

10. Click Next, and then click Finish. 
Once the account is created, the next step is to deploy PowerPivot for SharePoint. 

Deploy PowerPivot for SharePoint 
Deploying PowerPivot for SharePoint consists of the following steps: 

• Installing PowerPivot for SharePoint on a SharePoint Server farm 

• Deploying the PowerPivot solution package to a SharePoint Web Application 

• Activating PowerPivot feature integration for the Business Intelligence Center 
The first step is to install PowerPivot for SharePoint on the Contoso-AppSrv computer. 

 Tip:  
In our test environment, we are using a single computer for SharePoint Server. In a production 
environment where you might have more than one computer that is running SharePoint Server, 
install PowerPivot for SharePoint on the computer that has the SharePoint Central 
Administration Web site installed. 

To install PowerPivot for SharePoint 2010 on an existing SharePoint Server 2010 
farm 
1. Attach the SQL Server 2008 R2 DVD to the DVD drive for the Contoso-AppSrv virtual machine. 

2. Log on to Contoso-AppSrv by using the Contoso\FarmAdmin account. 

3. On the SQL Server DVD, double-click setup.exe. 
The SQL Server Installation Center opens. 

4. Click Installation, and then click New installation or add features to an existing installation. 
The SQL Server setup window opens. 

5. On the Setup Support Rules page, click OK. 

6. On the Product Key page, type the product key for your version of SQL Server, and then click 
Next. 

7. On the License Terms page, select I accept the license terms, and then click Next. 
8. On the Setup Support Files page, click Install. 
9. On the Setup Support Files page, click Next. 
10. On the Setup Role page, select SQL Server PowerPivot for SharePoint, and in the Add 

PowerPivot for SharePoint to list, select Existing Farm. Then click Next. 
11. On the Feature Selection page, click Next. 
12. On the Installation Rules page, click Next. 
13. On the Instance Configuration page, in the Instance ID box, select the default PowerPivot text, 

and type ContosoAppSrv, and then click Next. 
14. On the Disk Space Requirements page, click Next. 
15. On the Server Configuration page, in the SQL Server Analysis Services row, specify the 

Contoso\PowerPivotSSAS account and password. Then click Next. 
16. On the Analysis Services Configuration, click Add Current User, and then click OK. 

17. On the Analysis Services Configuration page, click Next. 



 

18. On the Error Reporting page, click Next. 
19. On the Installation Configuration Rules page, click Next. 
20. On the Ready to Install page, click Install. 

The installation process runs. 

 Tip:  
It might take several minutes for the installation process to finish. 

21. After the installation process is complete, you must restart the computer. On the Complete page, 
click Close. Then restart the Contoso-AppSrv computer. 

The next step is to deploy a PowerPivot solution to the SharePoint Web application that you created 
when you set up the baseline environment. 

To deploy the PowerPivot solution package 
1. Log into the Contoso-AppSrv computer by using the Contoso\FarmAdmin account. 

2. Click the Start button, select All Programs, select Microsoft SharePoint 2010 Products, and 
then select SharePoint 2010 Central Administration. 

3. In SharePoint 2010 Central Administration, click System Settings, and then click Manage farm 
solutions. 

 Note:  
There are two separate solution packages visible: powerpivotfarm.wsp and 
powerpivotwebapp.wsp. The first solution, powerpivotfarm.wsp, is deployed automatically 
when you install the first PowerPivot for SharePoint instance. You do not have to deploy 
this again. The second solution, powerpivotwebapp.wsp, is deployed automatically for 
Central Administration. However, you must deploy this solution manually for each 
SharePoint Web application that supports PowerPivot for SharePoint data access. 
In this case, we have one Web application. In a production environment, there are likely 
more than one Web application. 

4. Click powerpivotwebapp.wsp, and then click Deploy Solution. 

5. In the Deploy To? section, use the Choose a Web application to deploy this solution list to 
select http://contoso-appsrv/. 

6. Click OK. 
The next step is to configure the Business Intelligence Center to work with PowerPivot data. To do this, 
follow these steps. 

To enable PowerPivot feature integration with the Business Intelligence Center 
1. Browse to the Business Intelligence Center (http://contoso-appsrv/sites/bicenter). 

2. Click Site Actions, and then click Site Settings. 

3. In the Site Collection Administration section, click Site Collection Features. 

4. Next to PowerPivot Feature Integration for Site Collections, click Activate. 

5. Close the browser window. 
Now that PowerPivot for SharePoint is installed, the next step is to configure a PowerPivot service 
application. 

http://contoso-appsrv/
http://contoso-appsrv/sites/bicenter


 

Configure a PowerPivot service application 
 Tip:  

The procedures in this section describe how to configure a PowerPivot service application for a 
test environment that uses a particular configuration. For more detailed information about how 
to configure a PowerPivot service application for production environments, see Create and 
Configure a PowerPivot Service Application (http://go.microsoft.com/fwlink/p/?LinkId=226553).  

Configuring PowerPivot for SharePoint consists of the following steps: 

• Starting the Claims to Windows Token Service 

• Creating an Active Directory account for the application pool under which the PowerPivot service 
application will run 

• Registering that account as a managed account in SharePoint Server 2010 

• Creating a PowerPivot service application 

• Configuring Excel Services to support PowerPivot workbooks 
Begin by starting the Claims to Windows Token Service, which is used to enable access to data that is 
stored on another computer. In this case, we will be accessing data that is stored on the Contoso-SQL 
computer. 

To start the Claims to Windows Token Service 
1. Click Start, click All Programs, click Microsoft SharePoint 2010 Products, and then click 

SharePoint 2010 Central Administration. 

2. In Central Administration, click System Settings, and then click Manage services on server. 
3. Start the Claims to Windows Token Service. 

4. Verify that both SQL Server Analysis Services and SQL ServerPowerPivot System Service are 
started.  

The next step is to create an Active Directory account. This account will be used for the PowerPivot for 
SharePoint Service application. 

To create an Active Directory account for PowerPivot for SharePoint 
1. Log on to Contoso-DC as Contoso\Administrator. 

2. Click Start, click Administrative Tools, and then click Active Directory Users and Computers. 

3. Expand the contoso.local node. 

4. Right-click Users, click New, and then click User. 
5. In the Full name and User logon name boxes, type PowerPivotAppPool. 
6. Click Next. 
7. Type and confirm a password for the account. 

8. Clear the User must change password at next logon check box. 

9. Select the Password never expires check box. 

10. Click Next, and then click Finish. 
The next step is to register the managed account in SharePoint Server. 

To register the PowerPivotAppPool account in SharePoint Server 

http://go.microsoft.com/fwlink/p/?LinkId=226553�
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1. Log on to Contoso-AppSrv by using the Contoso\FarmAdmin account. 

2. Click Start, click All Programs, click Microsoft SharePoint 2010 Products, and then click 
SharePoint 2010 Central Administration. 

3. On the SharePoint Central Administration Web site home page, in the left navigation, click 
Security. 

4. On the Security page, under General Security, click Configure managed accounts. 

5. On the Managed Accounts page, click Register Managed Account. 
6. In the User name box, type Contoso\PowerPivotAppPool. 
7. In the Password box, type the password for the Contoso\PowerPivotAppPool account. 

8. Click OK. 
The next step is to create a PowerPivot service application. 

To create a PowerPivot service application 
1. In Central Administration, click Application Management, and then click Manage service 

applications. 

2. In the Service Applications ribbon, click New, and then click SQL Server PowerPivot Service 
Application.  
The Create New PowerPivot Service Application dialog box appears. 

3. In the Name box, type PowerPivotServiceApplication1. 

4. In the Application Pool section, select Create a new application pool, and in the Application 
pool name box, type PowerPivotServAppPool.  

5. Use the Configurable list to select Contoso\PowerPivotAppPool. 
6. In the Database Server list, specify Contoso-SQL, and keep the default database name. 

7. In the Database authentication section, keep the default setting, Windows Authentication. 

8. In the Default section, select the check box for Add the proxy for this PowerPivot service 
application to the default proxy group, and then click OK. 

9. After your service application is successfully created, click OK in the confirmation page. 
The service application appears in the Contoso farm service application list together with the other 
service applications. You might have to refresh the page to see it. 
The next step is to configure Excel Services to support PowerPivot workbooks. To do this, you increase 
the maximum file size for Excel Services and edit external data settings.  

To configure Excel Services to support PowerPivot workbooks 
1. In Central Administration, click Application Management, and then click Manage service 

applications. 

2. Click Excel Services. 

3. Click Trusted File Locations. 

4. Click http://contoso-appsrv/sites/bicenter/documents. 

5. In the Workbook Properties section, in the Maximum Workbook Size box, type 50. 
Increasing the workbook size makes it possible to work with more data in PowerPivot for Excel. 

6. In the External Data section, under Allow External Data, select Trusted data connection 
libraries and embedded. 

http://contoso-appsrv/sites/bicenter/documents


 

7. In the External Data section, clear the Refresh warning enabled check box. 

8. Click OK. 
Now that you have installed and configured PowerPivot for SharePoint, your next step is to configure 
data refresh for PowerPivot for SharePoint.  

Configure data refresh for PowerPivot for SharePoint 
Configuring data refresh for PowerPivot data in Excel workbooks consists of the following steps: 

• Creating an Active Directory account for the PowerPivot unattended data refresh account 

• Granting Read permissions to access the data during data refresh 
The first step is to create an Active Directory account. 

To create an Active Directory account for PowerPivot data refresh 
1. Log on to Contoso-DC by using the Contoso\Administrator account. 

2. Click Start, click Administrative Tools, and then click Active Directory Users and Computers. 

3. Expand the contoso.local node. 

4. Right-click Users, click New, and then click New User. 
5. In the Full name and User logon name boxes, type PowerPivotUnattended, and then click Next. 
6. Type and confirm a password for the account. 

7. Clear the User must change password at next logon check box. 

8. Select the Password never expires check box. 

9. Click Next, and then click Finish. 
Once the Active Directory account is created, the next step is to grant Read permissions to that account 
in SQL Server. 

To grant Read permissions to the PowerPivot unattended data refresh account 
in SQL Server 
1. Log on to the Contoso-SQL computer by using the Contoso\SQLAdmin account. 

2. Click Start, click All Programs, click Microsoft SQL Server 2008 R2, and then click SQL Server 
Management Studio. 

3. In the Connect to Server dialog box, specify the following settings:  

• In the Server type list, select Database Engine.  

• In the Server name box, type Contoso-SQL.  
Then click Connect. 

4. In the Object Explorer pane, expand Security. 

5. Right-click Logins, and then click New Login. 

6. In the Login name box, type Contoso\PowerPivotUnattended. 

7. In the Select a Page section, click User Mapping. 

8. Select the Map check box for the ContosoRetailDW database, and then, under Database role 
membership for: ContosoRetailDW, select the db_datareader check box. 

9. Click OK. 



 

10. Close SQL Server Management Studio, and then log off the Contoso-SQL computer. 
The next step is to create a Secure Store target application. 

Configure Secure Store service for PowerPivot for 
SharePoint 
Configuring Secure Store Service for PowerPivot for SharePoint consists of the following steps: 

• Creating a PowerPivot target application for the Secure Store Service 

• Specifying the target application identity for the PowerPivot unattended data refresh account 

• Granting Contribute permissions to the PowerPivot unattended data refresh account in SharePoint 
Server 

The first step is to create a PowerPivot target application for Secure Store Service. 

To create a PowerPivot target application for Secure Store Service 
1. Log on to Contoso-AppSrv by using the Contoso\FarmAdmin account. 

2. Click Start, click All Programs, click Microsoft SharePoint 2010 Products, and then click 
SharePoint 2010 Central Administration.  

3. On the Central Administration home page, in the Application Management section, click Manage 
service applications. 

4. In the list of service applications, click Secure Store Service. 

5. In the ribbon, on the Edit tab, click New. 

6. On the Target Application Settings page, specify the following settings: 

• In the Target Application ID box, type PowerPivotDataRefresh. 

• In the Display Name box, type PowerPivotDataRefresh. 

• In the Contact E-mail box, type an e-mail address. For our example, we use 
farmadmin@contoso.local. 

• In the Target Application Type list, select Group. 

• In the Target Application Page URL section, select None. 
Then click Next. 

7. On the Specify the credential fields for your Secure Store Target Application page, keep the 
default values, and then click Next. 

8. On the Create New Secure Store Service Application page, specify the following settings 

• In the Target Application Administrators box, type Contoso\FarmAdmin. 

• In the Members box, type the name of the application pool identity for the PowerPivot service 
application. For our example, we use PowerPivotAppPool. 
Then click OK. 
The list of Secure Store Service target applications is displayed. Do not close this window. 

The next step is to set credentials for the target application. 

To set credentials for the PowerPivot target application 



 

1. Begin with the list of Secure Store Service target applications open. Select the check box next to 
PowerPivotDataRefresh. 

2. In the ribbon, on the Edit tab, in the Credentials section, click Set. 
3. On the Set Credentials for Secure Store Target Application (Group) page, specify the following 

settings: 

• In the Windows User Name box, type Contoso\PowerPivotUnattended. 

• In the Windows Password and the Confirm Windows Password boxes, type the password 
for the Contoso\PowerPivotUnattended account. 
Then click OK. 
The list of Secure Store Service target applications is displayed. Do not close this window. 

The next step is to specify a PowerPivot unattended data refresh account. 

To specify a target application identity for the PowerPivot unattended data 
refresh account 
1. In Central Administration, in the Application Management section, click Manage service 

applications. 

2. In the list of service applications, click the name of the PowerPivot service application. For our 
example, we click PowerPivotServiceApplication1. 
The PowerPivot Management Dashboard opens. 

3. In the Actions section, click Configure service application settings. 
The PowerPivot Settings page opens. 

4. In the Data Refresh section, in the PowerPivot Unattended Data Refresh Account box, type the 
name of the target application identity. For our example, we use PowerPivotDataRefresh. 
Then click OK. 

5. Close Central Administration, but remain logged in to the Contoso\FarmAdmin account. 
The next step is to grant Contribute permissions to the PowerPivotUnattended account in SharePoint 
Server. This enables users to open PowerPivot workbooks from a SharePoint library and save it after 
refreshing data. 

To grant Contribute permissions to the PowerPivot unattended data refresh 
account in SharePoint Server 
1. Open a Web browser and navigate to the Contoso team site. For our example, the Web site 

address (URL) is http://contoso-appsrv. 

2. Click BI Center to open the Business Intelligence Center. 

3. Click Site Actions, and then click Site Permissions. 

4. In the ribbon, on the Edit tab, click Grant Permissions. 

5. In the Grant Permissions dialog box, specify the following settings: 

• In the Users/Groups box, type the name of the PowerPivot unattended data refresh account. 
For our example we use Contoso\PowerPivotUnattended. 

• In the Grant Permissions section, select Add users to a SharePoint group (recommended), 
and then select Business Intelligence Center Members [Contribute]. 
Then click OK. 

http://contoso-appsrv


 

6. Close the Web browser, and then log off the Contoso-AppSrv computer. 
Now that PowerPivot for SharePoint is deployed, the next step is to verify that PowerPivot for 
SharePoint is configured correctly.  

Verify that PowerPivot for SharePoint is configured 
correctly 
Verifying that PowerPivot for SharePoint is configured correctly consists of the following steps:  

• Installing the PowerPivot add-in for Excel on a client computer 

• Creating and publishing a PowerPivot workbook to SharePoint Server 
Before you can install the PowerPivot add-in for Excel, you must verify that Microsoft .NET Framework 
3.5.1 is installed on the client computer. 

 Important:  
Before you begin to perform the tasks that are described in this section, make sure that you 
have Internet access on the Contoso-Client virtual machine. 

To install the Microsoft .NET Framework 3.5.1 
1. Log on to Contoso-Client by using the Contoso\Administrator account. 

2. Click Start, and then click Control Panel. 
3. Click Programs. 

4. In the Programs and Features section, click Turn Windows features on or off. 
The Windows Features dialog box appears. 

5. Select the Microsoft .NET Framework 3.5.1 check box, and then click OK. 

6. After Microsoft .NET Framework is installed, close the Control Panel. Do not log off the computer. 
The next step is to download and install PowerPivot for Excel. 

To install PowerPivot for Excel 
1. Open a web browser. 

2. In the address line, type http://go.microsoft.com/fwlink/?LinkID=224183. 
The Microsoft Download Center page for Microsoft SQL Server 2008 R2 - PowerPivot for Microsoft 
Excel 2010 – RTM opens. 

3. Click the Download button for PowerPivot for Excel. 

4. If a dialog box appears that prompts you to run or save the application, click Run. 
The PowerPivot for Excel Setup dialog box appears. 

5. On the welcome page, click Next. 
6. On the License Agreement page, select I accept the terms in the license agreement, and then 

click Next. 
7. On the Registration Information page, in the Name box, type your name, and then click Next. 
8. On the Ready to Install the Program page, click Install. 
9. On the Completing the PowerPivot for Excel installation page, click Finish. 

10. Close the web browser. Log off the computer. 

http://go.microsoft.com/fwlink/?LinkID=224183


 

The next step is to open Microsoft Excel and create a PowerPivot workbook. 

To create a PowerPivot workbook 
1. Log on to the Contoso-Client computer by using the Contoso\Susan.Burk account. 

2. Click Start, click All Programs, click Microsoft Office, and then click Microsoft Excel 2010. 

3. If Excel opens and displays a Microsoft Office Customization Installer dialog box, click Install.  
PowerPivot for Excel adds a PowerPivot tab to the Excel workbook. 

4. In Excel, on the PowerPivot tab, in the Launch group, click PowerPivot Window. 
The PowerPivot window opens. 

5. On the Home tab, click From Database, and then click From SQL Server. 
The Table Import Wizard dialog box appears. 

6. On the Connect to a Microsoft SQL Server Database page, in the Server name box, type 
Contoso-SQL. 

7. Use the Database name list to select ContosoRetailDW, and then click Test Connection. 

8. If your connection is successful, click Next. 
9. On the Choose How to Import the Data page, select the Select from a list of tables and views 

to choose the data to import option, and then click Next. 
10. In the Select Tables and Views page, select the check box next to the DimPromotion table, and 

then click Finish. 
The Importing page indicates that 28 rows of data were transferred. 

11. Click Close to close the Table Importing Wizard. 
The data is displayed in the PowerPivot window. 

12. On the Home tab, in the Reports group, click PivotTable down arrow, and then click PivotChart. 
The Create PivotChart dialog box appears. 

13. Select Existing Worksheet, and then click OK. 
An empty chart opens in Excel. 

14. In the PowerPivot Field List pane, select the check boxes for PromotionDescription and 
DiscountPercent. 
The chart updates to display data. 

15. From the PowerPivot Field List pane, drag StartDate to the Slicers Horizontal box. 
A box that contains slicers is added to the page, over the PivotChart report. 
Do not close the workbook. 

The next step is to publish the workbook to SharePoint Server. 

To publish the workbook 
1. In Excel, click the File tab, and then click Save & Send. 

2. Click Save to SharePoint. 
3. Under Locations, click Browse for a location, and then click Save As. 

The Save As dialog box appears. 

4. In the location box at the top of the window, type http://contoso-
appsrv/sites/BICenter/Documents. 

http://contoso-appsrv/sites/BICenter/Documents
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 Note:  
It might take some time for the Save As dialog box to refresh and show the site content. 

5. In the File name box, type ContosoPromotions.xlsx. 

6. Select the Open with Excel in the browser check box, and then click Save. 
A browser window opens and displays a cached version of the ContosoPromotions workbook.  

7. In the browser window, click a slicer, such as one that has an August date. Notice that the word 
“school” is misspelled as “scholl.” This is an error in the underlying database that we will correct, 
and then you can see how data refresh works. 
Close the browser window. 

The next step is to configure data refresh settings for the PowerPivot workbook.  

To configure data refresh settings for the PowerPivot workbook 
1. Open a web browser and navigate to the Business Intelligence Center Documents library. For 

example, we use http://contoso-appsrv/sites/bicenter/documents. 

2. Point to the ContosoPromotions file, click the down arrow that appears, and then click Manage 
PowerPivot Data Refresh.  

3. On the Manage Data Refresh page, select the Enable check box, and then click OK. 
You have successfully installed and configured PowerPivot for SharePoint. 
To see how the slicers work, click different slicers. The PivotChart report is updated to display 
information for that particular Start Date. To apply more than one slicer, hold down the Ctrl key, click the 
slicers that you want to use, and then release the Ctrl key and the mouse. 
The next step is to verify that data refresh is working correctly.  

Test data refresh 
To confirm that data refresh works for PowerPivot workbooks, we follow these steps: 

• Refresh the data currently displayed in the browser on the Contoso-Client computer 

• Change a value in the ContosoRetailDW database 

• Refresh the data displayed in the browser on Contoso-Client again and confirm that the new 
information is displayed 

First, we refresh the existing data. Use the following procedure to refresh the data in the browser. 

To refresh the ContosoPromotions workbook in a browser window 
1. Begin with the ContosoPromotions workbook open in a browser window. 

In the browser, on the Data drop-down list, click Refresh All Connections. 

 Note:  
If a warning message appears, click OK. 

If PowerPivot for SharePoint is configured correctly, the data will refresh without error, although we will 
not see any changes in data values at this point. The next step is to change a value in the 
ContosoRetailDW database and confirm that the changes appear in the workbook. 

To update data in the ContosoRetailDW database 
1. Log on to Contoso-SQL by using the Contoso\SQLAdmin account. 

http://contoso-appsrv/sites/bicenter/documents


 

2. Click Start, click All Programs, click Microsoft SQL Server 2008 R2, and then click SQL Server 
Management Studio. 

3. On the Connect to Server dialog box, select Database Engine for the Server type, and then click 
Connect. 

4. In the toolbar, click New Query. 

5. Copy the following query to the query window: 
USE [ContosoRetailDW] 
GO 
UPDATE dbo.DimPromotion set dbo.DimPromotion.PromotionName = ‘European Back-to-School 
Promotion’ where dbo.DimPromotion.PromotionName = ‘European Back-to-Scholl Promotion’ 
GO 
UPDATE dbo.DimPromotion set dbo.DimPromotion.PromotionDescription = ‘European Back-to-
School Promotion’ where dbo.DimPromotion.PromotionDescription = ‘European Back-to-Scholl 
Promotion’ 
GO 
 
 

6. In the toolbar, click Execute. 
The next step is to return to the Contoso-Client virtual machine and refresh ContosoPromotions.xlsx in 
the browser window. 

 Note:  
If you see a warning that the page has expired, click OK and restart the procedure. 

To refresh the ContosoPromotions workbook 
1. Log on to Contoso-Client computer by using the Contoso\Susan.Burk account. 

2. Open a Web browser, navigate to the Business Intelligence Center Documents library, and open 
the ContosoPromotions.xlsx file. 
For example, we use the Web site address http://contoso-
appsrv/sites/bicenter/documents/contosopromotions.xlsx. 
The workbook opens in a browser window. 

3. In the browser, on the Data drop-down list, click Refresh All Connections. 

 Note:  
If a warning message appears, click OK. 

4. In the slicer section, click an August date. 
Notice that the report now displays the correct spelling of “school.” 

Concepts 
Configuring a BI infrastructure: Hands-on labs 

Other Resources 
PowerPivot for SharePoint (http://go.microsoft.com/fwlink/p/?LinkId=226555) 
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Configure Visio Services for a BI test 
environment 
Published: May 26, 2011 
Summary: This lab covers how to deploy a Visio Services service application and how to configure 
data access for users connecting data to shapes in Visio. 

 Important:  
This article is part of the Configuring a BI infrastructure: Hands-on labs series. To complete the 
steps in this article, you must first have completed: 

• All steps in the Create a baseline environment for a BI test environment series of articles. 
Visio Services in Microsoft SharePoint Server 2010 is a service application that lets users share and 
view Microsoft Visio Web drawings. The service also enables data-connected Microsoft Visio 2010 Web 
drawings to be refreshed and updated from various data sources. 
This lab consists of three sections: 

• Deploy Visio Services: In this section, we deploy the Visio Services service application on the 
Microsoft SharePoint Server 2010 farm. 

• Configure Visio Services Global Settings: In this section, we configure the cache settings for 
Visio Services so that we can easily demonstrate data refresh in later labs. 

• Configure Visio client access: In this section, we configure user data access from Microsoft Visio 
Premium 2010. 

Video demonstration 
This video shows how to configure Visio Services for use in these labs. 
  

 Running time: 10:03 

  Watch the video. 

  For an optimal viewing experience, 
download the video. 
Right-click the link, and then click Save Target As 
to download a copy. Clicking the link opens a 
.wmv file in the default video viewer for full-
resolution viewing. 
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Deploy Visio Services 
Deploying Visio Services consists of the following steps: 

• Creating an Active Directory account for the application pool under which the Visio Services service 
application will run. 

• Registering that account as a managed account in SharePoint Server 2010. 

• Starting the Visio Graphics Service. 

• Creating a Visio Services service application. 
The first step in deploying Visio Services is to create an account in the Active Directory directory service 
to run the application pool for the Visio Services service application. Use the following procedure to 
create the account. 

To create an account for the application pool 
1. Log on to Contoso-DC by using the Contoso\administrator account. 

2. On the Contoso-DC virtual machine, click Start, click Administrative Tools, and then click Active 
Directory Users and Computers. 

3. Expand the contoso.local node. 

4. Right-click Users, click New, and then click User. 
5. In the Full name text box and the User logon name text box, type VisioAppPool. 
6. Click Next. 
7. In the Password and Confirm password text boxes, type a password for the account. 

8. Clear the User must change password at next logon check box. 

9. Select the Password never expires check box. 

10. Click Next. 
11. Click Finish. 

12. Log off Contoso-DC. 
Once you have created the account, it must be registered as a managed account in SharePoint Server 
2010. Doing so makes the account available to service applications when you create them. Use the 
following procedure to register the managed account. 

To register a managed account 
1. Log in to Contoso-AppSrv using the Contoso\FarmAdmin account. 

2. Click Start, click All Programs, click Microsoft SharePoint 2010 Products, and then click 
SharePoint 2010 Central Administration. 

3. On the Central Administration home page, in the left navigation, click Security. 

4. On the Security page, under General Security, click Configure managed accounts. 

5. On the Managed Accounts page, click Register Managed Account. 
6. In the User name text box, type Contoso\VisioAppPool. 
7. In the Password text box, type the password for the Contoso\VisioAppPool account. 

8. Click OK. 



 

By default, the application pool account does not have the required access to the SharePoint content 
database. Access to this database is required for rendering data-connected Web drawings. Use the 
following procedure to grant the required database access to the application pool account. 

To grant content database access to the managed account 
1. On Contoso-AppSrv, click Start, click All Programs, click Microsoft SharePoint 2010 Products, 

right-click SharePoint 2010 Management Shell, and then click Run as Administrator. 
2. At the Windows PowerShell Command Prompt, type the following (press Enter after each line): 

Windows PowerShell  

$w = Get-SPWebApplication -identity http://contoso-appsrv 
$w.GrantAccessToProcessIdentity("Contoso\VisioAppPool") 

Once you have granted database access to the application pool account, you must start the Visio 
Graphics Service. This is the SharePoint Server 2010 service that performs all processing and activities 
associated with Visio Services. 
You must start this service on at least one application server. In a production environment, you would 
choose a server or servers on which to run the service, depending on your capacity requirements. 
Use the following procedure to start the Visio Graphics Service. 

To start the Visio Graphics Service 
1. On the Central Administration home page, under System Settings, click Manage services on 

server. 
2. Above the Service list, click the Server drop-down list, and then click Change Server. 

Note that the application server, Contoso-AppSrv, is listed together with Contoso-SQL. In a farm 
with multiple application servers, you would use this dialog box to select the server where you want 
to run Secure Store Service, and then start the service as shown here. 

3. Click CONTOSO-APPSRV. 

4. In the Service list, click Start next to Visio Graphics Service. 
Once the Visio Graphics Service has been started, you must create a Visio Services service 
application. Use the following procedure to create the service application. 

To create a Visio Graphics Service service application 
1. On the Central Administration home page, in the Application Management section, click Manage 

service applications. 

2. On the Manage Service Applications page, click New, and then click Visio Graphics Service. 

3. In the Visio Graphics Service Application Name section, type Visio Services in the text box. 

4. Select the Create new application pool option and type VisioServicesAppPool in the 
Application pool name text box. 

5. Select the Configurable option, and from the drop-down list, select CONTOSO\VisioAppPool. 
6. Click OK. 
Once the service application has been created, the next step is to configure the data refresh settings in 
Visio Services Global Settings. 

http://contoso-appsrv


 

Configure Visio Services Global Settings 
To efficiently demonstrate data refresh in the following Visio Services labs, we must change the default 
cache settings to allow for immediate data refresh. 

To configure the Visio Services minimum cache age 
1. On the Central Administration home page, under Application Management, click Manage service 

applications. 

2. In the list of service applications, click Visio Services. 

3. Click Global Settings. 

4. In the Minimum Cache Age text box, type 0. 

5. Click OK. 
In a production environment, setting the minimum cache age to zero (0) could put unnecessary strain 
on the server. We recommend that you leave the cache settings at their default values for best 
performance in a production environment. However, for this series of labs we want to be able to show 
immediate data refresh to validate that we have correctly configured data connectivity. 
Once you have finished configuring the cache settings in Visio Services Global Settings, the next step 
is to configure data access for diagram authors working in Microsoft Visio Professional 2010 and Visio 
Premium 2010. 

Configure Visio client access 
In the following Visio Services labs, we will be configuring data refresh for Visio Web drawings by using 
Secure Store Service. However, be aware that there are differences in the way that Visio Services and 
the Visio client application authenticate with data sources. 
Although Visio Services can use Secure Store Service to authenticate with a data source when 
rendering a data-connected Web drawing, Visio Professional 2010 and Visio Premium 2010 do not use 
Secure Store Service for data authentication. Visio Professional 2010 and Visio Premium 2010 require 
that diagram authors have direct database access in order to link data to shapes in Visio. 
In this case, we will create an Active Directory group to contain our diagram authors, and then create a 
SQL Server logon for that Active Directory group. In the following labs, we will grant the needed 
database access to this Active Directory group before creating a Visio diagram. 

To create an Active Directory group 
1. Log on to Contoso-DC by using the Contoso\administrator account. 

2. On the Contoso-DC virtual machine, click Start, click Administrative Tools, and then click Active 
Directory Users and Computers. 

3. Expand the contoso.local node. 

4. Right-click Users, click New, and then click Group. 

5. In the Group Name text box, type VisioDiagramAuthors, and then click OK. 
Next, we need to add users to the group. In this case, we will add the user Susan Burk to the group 
because Susan Burk has Contribute access to the Business Intelligence Center where we will be 
publishing our data-connected Web drawings in the following Visio Services labs. 

To populate the VisioDiagramAuthors Active Directory group 



 

1. In Active Directory Users and Computers, double-click the VisioDiagramAuthors group. 

2. On the Members tab, click Add. 

3. In the Enter object names to select box, type Contoso\Susan.Burk, and then click OK. 

4. Verify that Susan Burk appears in the Members list, and then click OK. 
Now that the Susan Burk account is added to the VisioDiagramAuthors group, the next step is to create 
a SQL Server logon for that group. 

To create a SQL Server logon 
1. Log on to Contoso-SQL by using the Contoso\SQLAdmin account. 

2. Click Start, click All Programs, click Microsoft SQL Server 2008 R2, and then click SQL Server 
Management Studio. 

3. Connect to the Database Engine. 

4. Expand the Security node. 

5. Right-click Logins, and then click New Login. 

6. On the Login – New page, click Search. 

7. On the Select User or Group dialog box, click Object Types. 

8. On the Object Types dialog box, select the Groups check box, and then click OK. 

9. On the Select User or Group dialog box, in the Enter the object name to select box, type 
Contoso\VisioDiagramAuthors, and then click OK. 

10. On the Login – New page, click OK. 
When you have completed all of the previous procedures, Visio Services will be operational and ready 
to use. The next step is to configure security access to your data sources. The following labs cover how 
to configure security access by using Secure Store Service: 

• Configure the Visio Services unattended service account in a BI test environment 

• Configure Visio Services data access by using Secure Store in a BI test environment 

Other Resources 
Configure Kerberos authentication for SharePoint 2010 Products (white paper) 
Data authentication for Visio Services (SharePoint Server 2010) 
  

http://technet.microsoft.com/library/e12e1d5f-d46e-4901-8f58-16f079c0d0ca(Office.14).aspx�
http://technet.microsoft.com/library/918a570e-ce86-4ff7-857f-d08dbb35d08d(Office.14).aspx�


 

 

Configure the Visio Services unattended 
service account in a BI test environment 
Published: May 26, 2011 
Summary: Read this example for a demonstration of how to connect data in a remote database to a 
Visio diagram by using an ODC file.  

 Important:  
This article is part of the Configuring a BI infrastructure: Hands-on labs series. To complete the 
steps in this article, you must first have completed: 

• All steps in the Create a baseline environment for a BI test environment series of articles. 

• All steps in Configure Visio Services for a BI test environment 
Visio Services in Microsoft SharePoint Server 2010 provides two methods of using Secure Store to 
refresh data in a data-connected Web drawing. One is by using the unattended service account and the 
other is by using an Office Data Connection (ODC) file. This lab covers the unattended service account 
option. For more information about how to use an ODC file, see Configure Visio Services data access 
by using Secure Store in a BI test environment. 
Using the unattended service account involves configuring access to your data for an Active Directory 
account, storing the credentials for this account in Secure Store, and configuring Visio Services to use 
this account when it needs to refresh the data in a data-connected Web drawing. 
The following steps are required to configure the unattended service account in Visio Services. 

• Configure a data access account 

• Configure Secure Store 

• Configure the Visio Services Global Settings 
In this lab, we will also create a small sample table in SQL Server and publish a Web drawing with data 
connected to the SQL Server table. 

Video demonstration 
This video shows how to set up the unattended service account for Visio Services. 
  

 Running time: 15:49 

  Watch the video. 

  For an optimal viewing experience, 
download the video. 
Right-click the link, and then click Save Target As 
to download a copy. Clicking the link opens a 
.wmv file in the default video viewer for full-

http://go.microsoft.com/fwlink/p/?LinkId=223445�
http://go.microsoft.com/fwlink/p/?LinkId=223389�


 

resolution viewing. 

  

Creating sample data 
When you configure the unattended service account, you have to grant the account access to the data 
source to which your Visio Web drawing will be connected. For the purposes of this lab, we will create a 
SQL Server table. The table contains some simple data that we can use in a data-connected Web 
drawing which we will publish to the SharePoint document library in the Business Intelligence Center. 
Use the following procedure to create the SQL Server table. 

To create a table with sample data 
1. Log on to Contoso-SQL by using the Contoso\SQLAdmin account. 

2. Click Start, click All Programs, click Microsoft SQL Server 2008 R2, and then click SQL Server 
Management Studio. 

3. On the Connect to Server dialog box, select Database Engine for the Server type, and then click 
Connect. 

4. On the toolbar, click New Query. 

5. Copy the following query to the query window: 
USE [master] 
GO 
CREATE DATABASE CorporateDirectory; 
GO 
USE [CorporateDirectory] 
GO 
CREATE TABLE [dbo].[Office]( 
[Name] [varchar] (50) NULL, 
[Office] [varchar] (50) NULL 
) ON [PRIMARY] 
GO 
INSERT INTO Office ([Name], [Office])  
VALUES ('John Woods', '1501'); 
GO 
INSERT INTO Office ([Name], [Office])  
VALUES ('Susan Burk', '1502'); 
GO 
INSERT INTO Office ([Name], [Office])  
VALUES ('Cindy White', '1503'); 
GO 
INSERT INTO Office ([Name], [Office])  
VALUES ('David Hamilton', '1504'); 
GO 
 

6. On the toolbar, click Execute. 
With the sample table created, the next step is to create an Active Directory account for use as the 
unattended service account. 



 

Configure a data access account 
The unattended service account requires an Active Directory account for data access. Use the following 
procedure to create the account. 

To create an Active Directory account for data access 
1. Log on to Contoso-DC as Contoso\Administrator. 

2. Click Start, click Administrative Tools, and then click Active Directory Users and Computers. 

3. Expand the contoso.local node. 

4. Right-click Users, click New, and then click User. 
5. In the Full name and User logon name text boxes, type VisioUnattended. 

6. Click Next. 
7. Type and confirm a password for the account. 

8. Clear the User must change password at next logon check box. 

9. Select the Password never expires check box. 

10. Click Next, and then click Finish. 
Once the account has been created, the next step is to grant that account read access to the required 
data. In a production scenario, you would grant access to whatever data source you need to access 
from your Visio Web drawing. In this lab we will grant access to the sample SQL Server database that 
we created earlier. Use the following procedure to create a SQL Server logon and grant that logon data 
reader access to the CorporateDirectory database. 

To create a SQL Server logon 
1. Log on to Contoso-SQL as Contoso\SQLAdmin. 

2. Click Start, click All Programs, click Microsoft SQL Server 2008 R2, and then click SQL Server 
Management Studio. 

3. On the Connect to Server dialog box, select Database Engine as the Server type, type 
Contoso-SQL in the Server name box, and then click Connect. 

4. In Object Explorer, expand Security. 

5. Right-click Logins, and then click New Login. 

6. In the Login name box, type Contoso\VisioUnattended. 

7. Under Select a page, click User Mapping. 

8. Select the Map check box for the CorporateDirectory database, and then under Database role 
membership for:CorporateDirectory, select the db_datareader check box. 

9. Click OK. 
With the account created and granted the appropriate data access, we can now configure Secure 
Store. 

Configure Secure Store 
Secure Store uses a target application to define connection parameters and authorized users. The 
unattended service account is generally considered a catch-all account that is used for general data 



 

access, so usually all users are granted access to the unattended service account through the target 
application. 
Use the following procedure to create a target application for the unattended service account. 

To create a target application for the unattended service account 
1. Log in to Contoso-AppSrv using the Contoso\FarmAdmin account. 

2. Click Start, click All Programs, click Microsoft SharePoint 2010 Products, and then click 
SharePoint 2010 Central Administration. 

3. On the SharePoint Central Administration Web site home page, in the Application Management 
section, click Manage service applications. 

4. Click the Secure Store Service service application. 

5. On the ribbon, click New. 

6. In the Target Application ID box, type VisioServicesUnattended. 

7. In the Display Name box, type VisioServicesUnattended. 

8. In the Contact E-mail box, type farmadmin@contoso.local. 

 Note:  
Although e-mail notifications are not configured in this environment, Contact E-mail is a 
required field. 

9. In the Target Application Type drop-down list, select Group. 

10. Click Next. 
11. Leave the default credential fields, and then click Next. 
12. On the Specify the membership settings page: 

a) In the Target Application Administrators box, type Contoso\FarmAdmin. 

b) In the Members box, type All Authenticated Users. 

 Note:  
In a production scenario, you would typically include all users here. You can restrict the users 
who have access to the unattended service account to a specific Active Directory group if you 
want, but be aware that only one unattended service account can be created per Visio Services 
service application. 

c) Click OK. 
Once the target application has been created, you must specify which credentials should be used by it. 
The target application credentials are those to which data access has been granted — in our case, the 
Contoso\VisioUnattended account to which we granted db_datareader access to the 
CorporateDirectory database. 
Use the following procedure to set the credentials for the target application. 

To set the credentials for the target application 
1. On the Secure Store Service Application page, in the Target Application ID column, point to 

VisioServicesUnattended, click the arrow that appears, and then click Set Credentials. 

2. In the Windows User Name box, type Contoso\VisioUnattended. 

3. Type and confirm the password for the Contoso\VisioUnattended account. 

4. Click OK. 



 

With the credentials set for the target application, the Secure Store configuration for the unattended 
service account is complete. The next step is to configure Visio Services to use this target application 
for the unattended service account. 

Configure Visio Services 
The unattended service account configuration is part of the Visio Services Global Settings. Use the 
following procedure to configure the unattended service account in Visio Services. 

To configure Visio Services Global Settings 
1. On the Central Administration home page, under Application Management, click Manage service 

applications. 

2. On the Manage Service Applications page, click Visio Services. 

3. On the Manage the Visio Graphics Service page, click Global Settings. 

4. On the Visio Graphics Service Settings page, in the External Data section, in the Application ID 
box, type VisioServicesUnattended. 

5. Click OK. 
With the Visio Services Global Settings configured, setup of the unattended service account is 
complete. In the next section, we will create a data-connected Web drawing, publish it to a SharePoint 
document library, and render it by using Visio Services. This enables us to test data refresh by using 
the unattended service account. 

Grant database access to the diagram author 
When Visio Services renders a data-connected Web drawing, it can use Secure Store and the 
unattended service account to refresh the data. However, Microsoft Visio does not use Secure Store or 
the unattended service account, but instead requires the user to have direct database access to work 
with a data-connected diagram. Because of this, in order to create a data-connected diagram in Visio, 
we must first grant Read access to the CorporateDirectory database to the user who will create the 
diagram. 
In Configure Visio Services for a BI test environment, we created an Active Directory group named 
VisioDiagramAuthors for granting database access to diagram authors. We must now grant 
db_datareader access to that group for the CorporateDirectory database. 
Use the following procedure to grant database access to the Contoso\VisioDiagramAuthors group. 

To grant database access to a user 
1. Log on to Contoso-SQL as Contoso\SQLAdmin. 

2. Click Start, click All Programs, click Microsoft SQL Server 2008 R2, and then click SQL Server 
Management Studio. 

3. Connect to the Database Engine. 

4. In SQL Server Management Studio, expand Security, and then expand Logins. 

5. Right-click the Contoso\VisioDiagramAuthors logon, and then click Properties. 

6. In the pane on the left side, click User Mapping. 

7. Select the Map check box for the CorporateDirectory database. 



 

8. In the Database role membership for: CorporateDirectory list, select the db_datareader check 
box, and then click OK. 

Publishing a data-connected web drawing 
To confirm that we have successfully configured Visio Services and the unattended service account, we 
will create a data-connected Web drawing that uses the CorporateDirectory table that we created in 
SQL Server. 

To create a diagram 
1. Log on to Contoso-Client by using the Contoso\Susan.Burk account. 

2. Click Start, click All Programs, click Microsoft Office, and then click Microsoft Visio 2010. 

3. On the Choose a Template page, in the Template Categories section, click Maps and Floor 
Plans. 

4. Click Floor Plan, and then click Create. 

5. From the Shapes list, drag four Room shapes onto the page and organize them in two rows of two 
with a small space between the rows. 

6. Drag a Door shape onto the bottom wall of each of the top two Room shapes. 

7. Drag a Door shape onto the top wall of each of the bottom two Room shapes. 
You should now have a diagram that resembles the following: 

 The next step is to connect the data in the 
CorporateDirectory database to the floor plan that we just created. 

To connect the Visio diagram to data 
1. On the ribbon, click the Data tab, and then click Link Data to Shapes. 

2. On the Data Selector page of the wizard, click Microsoft SQL Server database, and then click 
Next. 



 

3. On the Connect to Database Server page, type Contoso-SQL in the Server name box, and then 
click Next. 

4. On the Select Database and Table page select CorporateDirectory from the drop-down list, and 
then click Next. 

5. On the Save Data Connection File and Finish page, click Finish. 

 Note:  
If you are prompted to overwrite the existing data connection file, click Yes. 

6. On the Select Data Connection page, click Next. 
7. On the Connect to data page, click Next. 
8. On the Configure Refresh Unique Identifier page, clear the Name check box and select the Office 

check box. 

9. Click Finish. 

10. On the drawing page: 

a) From the External Data section, drag John Woods to the upper-left office in the drawing. 

b) Select the upper-left office in the drawing, and then on the Data tab, click Data Graphics, 
and then click Edit Data Graphic. 

c) Select the Name row in the Data Field list, and then in the Default position section, select 
Left from the Horizontal drop-down list. 

d) With the Name row still selected, click Edit Item. 

e) From the Style list, select Heading 3, and then click OK. 

f) Select the Office row in the Data Field list, and then in the Default position section, ensure 
that Horizontal is set to Left. 

g) With the Office row still selected, click Edit Item. 

h) From the Style list, select Heading 3, and then click OK. 

i) Click OK. 

j) From the External Data section, drag Susan Burk to the lower-left office in the diagram 
(under John Woods). 

k) From the External Data section, drag Cindy White to the upper-right office in the diagram 
(to the right side of John Woods). 

l) From the External Data section, drag David Hamilton to the lower-right office in the 
diagram (under Cindy White). 

11. Leave the diagram open for the next procedure. 
You should now see a diagram similar to the following. 



 

 The next step is to publish this diagram to 
the Business Intelligence Center as a data-connected Web drawing. 

To publish a data-connected Web drawing 
1. Click File, and then click Save & Send. 

2. Click Save to SharePoint. 
3. Under Locations, click Browse for a location. 

4. Under File Types, click Web Drawing. 

5. Click Save As. 

6. On the Save As dialog box, type http://contoso-appsrv/sites/BICenter in the location box at the 
top, and then press Enter. 

 Note:  
It may take some time for the dialog box to refresh and show the site content. 

7. In the All Site Content list, double-click Documents. 

8. Ensure that the Automatically view files in browser check box is selected. 

9. In the File name box, type Floor plan, and then click Save. 
The Web drawing renders in a browser window. 

10. When the drawing is displayed, if a Refresh Disabled warning is displayed, click Enable (always). 
Leave this browser window open for the data refresh test procedure that follows. 

The rendered Web drawing shows the data currently in the CorporateDirectory database. To test the 
data refresh mechanism, we can modify the data in the Office table in SQL Server and then refresh the 
Web drawing to see the change. 
Use the following procedure to modify the data in SQL Server and then refresh the Web drawing. 

 Note:  
Remain logged in to Contoso-Client as Susan Burk while you do this procedure. 

To test Visio Services data refresh 

http://contoso-appsrv/sites/BICenter


 

1. Log on to Contoso-SQL by using the Contoso\SQLAdmin account. 

2. Click Start, click All Programs, click Microsoft SQL Server 2008 R2, and then click SQL Server 
Management Studio. 

3. On the Connect to Server dialog box, select Database Engine for the Server type, and then click 
Connect. 

4. In the toolbar, click New Query. 

5. Copy the following query to the query window: 
USE [CorporateDirectory] 
GO 
UPDATE dbo.Office set dbo.Office.Name = 'David Hamilton' where dbo.Office.Office = '1501' 
GO 
UPDATE dbo.Office set dbo.Office.Name = 'John Woods' where dbo.Office.Office = '1504' 
GO 

6. In the toolbar, click Execute. 

7. Return to Contoso-Client where the Server Status Web drawing is displayed. 
Note that in the original drawing, John Woods is in office 1501 and David Hamilton is in office 1504. 

8. On the Visio Web Access toolbar, click Refresh. 
Note that John Woods and David Hamilton have now swapped offices, reflecting the manual 
changes we made in SQL Server. 

 Note:  
The Visio Services cache settings affect how quickly the new results appear when you 
refresh the drawing. In the Configure Visio Services for a BI test environment lab, we set 
the cache settings to zero (0), allowing immediate refresh. In a production environment, 
refresh will likely take longer depending on how you configure the cache. 

Other Resources 
Plan Visio Services security (SharePoint Server 2010) 
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Configure Visio Services data access by using 
Secure Store in a BI test environment 
Published: May 26, 2011 
Summary: Read this example for a demonstration of how to connect data in a remote database to a 
Visio diagram by using an ODC file. 

 Important:  
This article is part of the Configuring a BI infrastructure: Hands-on labs series. To complete the 
steps in this article, you must first have completed: 

• All steps in the Create a baseline environment for a BI test environment series of articles. 

• All steps in Configure Visio Services for a BI test environment 
Visio Services in Microsoft SharePoint Server 2010 provides two methods of using Secure Store to 
refresh data in a data-connected Web drawing. One is by using the unattended service account and the 
other is by using an Office Data Connection (ODC) file. This lab covers the ODC file option. For more 
information about how to use the unattended service account, see Configure the Visio Services 
unattended service account in a BI test environment. 

 Note:  
ODC files must be created in Microsoft Excel 2007 or Microsoft Excel 2010. You must have 
Excel together with Microsoft Visio Professional 2010 or Microsoft Visio Premium 2010 installed 
on the Contoso-Client virtual machine to complete this lab. 

Using the unattended service account involves configuring access to your data for an Active Directory 
account, storing the credentials for this account in Secure Store, and configuring Visio Services to use 
this account when it needs to refresh the data in a data-connected Web drawing. 
The following steps are required to configure the unattended service account in Visio Services. 

• Configure a data access account 

• Configure Secure Store 

• Configure the Visio Services Global Settings 
In this lab, we will also create a small sample table in SQL Server and publish a Web drawing with data 
connected to the SQL Server table. 

Video demonstration 
This video shows how to set up data access for Visio Services using Secure Store. 
  



 

 Running time: 14:41 

  Watch the video. 

  For an optimal viewing experience, 
download the video. 
Right-click the link, and then click Save Target As 
to download a copy. Clicking the link opens a 
.wmv file in the default video viewer for full-
resolution viewing. 

  

Creating sample data 
When configuring data access through Secure Store, you have to grant the account access to the data 
source to which your Visio Web drawing will be connected. For the purposes of this lab, we will create a 
SQL Server table. The table contains some simple data which we can use in a data-connected Web 
drawing which we will publish to a document library in the Business Intelligence Center. 
Use the following procedure to create the SQL Server table. 

To create a table with sample data 
1. Log on to Contoso-SQL by using the Contoso\SQLAdmin account. 

2. Click Start, click All Programs, click Microsoft SQL Server 2008 R2, and then click SQL Server 
Management Studio. 

3. On the Connect to Server dialog box, select Database Engine for the Server type, and then click 
Connect. 

4. On the toolbar, click New Query. 

5. Copy the following query to the query window: 
USE [master] 
GO 
CREATE DATABASE ServerStatus; 
GO 
USE [ServerStatus] 
GO 
CREATE TABLE [dbo].[Status]( 
[Server] [varchar](50) NULL, 
[Status] [bit] NULL 
) ON [PRIMARY] 
GO 
INSERT INTO Status ([SERVER], [Status])  
VALUES ('Seattle', 'TRUE'); 
GO 
INSERT INTO Status ([SERVER], [Status])  
VALUES ('New York', 'TRUE'); 
GO 
INSERT INTO Status ([SERVER], [Status])  

http://go.microsoft.com/fwlink/p/?LinkId=223446�
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VALUES ('London', 'FALSE'); 
GO 

6. On the toolbar, click Execute. 
With the sample table created, the next step is to create an Active Directory account for use as the data 
access account. 

Configure a data access account 
Secure Store maps users designated to have data access to an account that has data access. For this 
lab, we will create an Active Directory account and give it access to the ServerStatus database that we 
created in the previous section. Use the following procedure to create the account. 

To create an Active Directory account for data access 
1. Log into Contoso-DC as Contoso\Administrator. 

2. Click Start, click Administrative Tools, and then click Active Directory Users and Computers. 

3. Expand the contoso.local node. 

4. Right-click Users, click New, and then click User. 
5. In the Full name and User logon name boxes, type VisioDataAccess. 

6. Click Next. 
7. Type and confirm a password for the account. 

8. Clear the User must change password at next logon check box. 

9. Select the Password never expires check box. 

10. Click Next, and then click Finish. 
Once the account has been created, the next step is to grant that account read access to the required 
data. In a production scenario, you would grant access to whatever data source that you need to 
access from your Visio Web drawing. In this lab we will grant access to the sample SQL Server that we 
created earlier. Use the following procedure to create a SQL Server logon and grant that logon data 
reader access to the ServerStatus table. 

To create a SQL Server logon 
1. Log on to Contoso-SQL as Contoso\SQLAdmin. 

2. Click Start, click All Programs, click Microsoft SQL Server 2008 R2, and then click SQL Server 
Management Studio. 

3. On the Connect to Server dialog box, select Database Engine as the Server type, type 
Contoso-SQL in the Server name box, and then click Connect. 

4. In Object Explorer, expand Security. 

5. Right-click Logins, and then click New Login. 

6. In the Login name box, type Contoso\VisioDataAccess. 

7. Under Select a page, click User Mapping. 

8. Select the Map check box for the ServerStatus database, and then under Database role 
membership for: ServerStatus, select the db_datareader check box. 

9. Click OK. 



 

Now that the Contoso\VisioDataAccess account has access to the ServerStatus database that we 
created, the next step is to configure Secure Store. 

Configure Secure Store 
Configuring Secure Store involves three steps: 

• Determine which users should have data access through Secure Store 

• Create a Secure Store target application that contains those users 

• Map the target application to the credentials that have data access 
Generally, you will want to provide data access to multiple users. The easiest way to manage that is by 
creating an Active Directory group and then populating that group with the users to whom you want to 
grant data access. 
Use the following procedure to create the Active Directory group. 

To create an Active Directory group for user data access 
1. Log on to Contoso-DC using the Contoso\Administrator account. 

2. Click Start, click Administrative Tools, and then click Active Directory Users and Computers. 

3. Expand the contoso.local node. 

4. Right-click Users, click New, and then click Group. 

5. In the Group name box type VisioDataAccessGroup. 

6. Click OK. 
Next, we will populate the group with the users to whom we want to grant data access. In this case, we 
will use the Susan Burk and John Woods accounts. Use the following procedure to populate the 
VisioDataAccessGroup. 

To populate the data access group 
1. In Active Directory Users and Computers, in the users list, double-click the 

VisioDataAccessGroup group. 

2. On the Members tab, click Add. 

3. On the Select Users dialog box, type Contoso\susan.burk; Contoso\john.woods, and then click 
OK. 
The Members tab should now show Susan Burk and John Woods as members of the group. 

4. Click OK. 
The next step is to create a Secure Store target application that contains the VisioDataAccessGroup 
group. Use the following procedure to create the target application. 

To create a target application 
1. Log on to the Contoso-AppSrv virtual machine using the Contoso\FarmAdmin account. 

2. Click Start, click All Programs, click Microsoft SharePoint 2010 Products, and then click 
SharePoint 2010 Central Administration. 

3. On the Central Administration home page, under Application Management, click Manage service 
applications. 

4. Click the Secure Store Service service application. 



 

5. On the ribbon, click New. 

6. In the Target Application ID box, type VisioServicesData. 

7. In the Display Name box, type VisioServicesData. 

8. In the Contact E-mail box, type farmadmin@contoso.local. 

 Note:  
Although e-mail notifications are not configured in this environment, Contact E-mail is a 
required field. 

9. In the Target Application Type drop-down list, select Group. 

10. Click Next. 
11. Leave the default credential fields, and then click Next. 
12. On the Specify the membership settings page: 

a) In the Target Application Administrators box, type Contoso\FarmAdmin. 

b) In the Members box, type Contoso\VisioDataAccessGroup. 

c) Click OK. 
Now that the target application has been created, we must associate it with the credentials that have 
data access (the Contoso\VisioDataAccess account). Use the following procedure to set the credentials 
for the target application. 

To set the credentials for the target application 
1. On the Secure Store Service Application page, in the Target Application ID column, point to 

VisioServicesData, click the arrow that appears, and then click Set Credentials. 

2. In the Windows User Name box, type Contoso\VisioDataAccess. 

3. Type and confirm the password for the Contoso\VisioDataAccess account. 

4. Click OK. 
The Secure Store configuration is now complete. In the next section, we will configure data access for 
the Microsoft Visio user who will be creating data-connected Web drawings. 

Grant database access to the diagram author 
When Visio Services renders a data-connected Web drawing, it can use Secure Store to refresh the 
data. However, Excel and Visio do not use Secure Store, but instead require the user to have direct 
database access to work with an ODC file or a data-connected diagram. Because of this, we must first 
grant Read access to the ServerStatus database to the user who will create the diagram. 
In Configure Visio Services for a BI test environment, we created an Active Directory group named 
VisioDiagramAuthors for granting database access to diagram authors. We must now grant 
db_datareader access to that group for the ServerStatus database. 
Use the following procedure to grant database access to the Contoso\VisioDiagramAuthors group. 

To grant database access to a user 
1. Log on to Contoso-SQL by using the Contoso\SQLAdmin account. 

2. Click Start, click All Programs, click Microsoft SQL Server 2008 R2, and then click SQL Server 
Management Studio. 

3. Connect to the Database Engine. 



 

4. In SQL Server Management Studio, expand Security, and then expand Logins. 

5. Right-click the Contoso\VisioDiagramAuthors logon, and then click Properties. 

6. In the pane on the left side, click User Mapping. 

7. Select the Map check box for the ServerStatus database. 

8. In the Database role membership for: ServerStatus list, select the db_datareader check box, 
and then click OK. 

With configuration of database access for the Contoso\VisioDiagramAuthors group complete, the next 
step is to create an Office Data Connection file. 

Create an Office Data Connection file 
Visio cannot create an Office Data Connection (ODC) file, so we must create one in Excel, publish it to 
a data connection library, and then connect to it from Visio. 
Use the following procedure to create and publish the ODC file in Excel. 

To create and publish an ODC file 
1. Log on to Contoso-Client as Contoso\Susan.Burk. 

2. Click Start, click All Programs, click Microsoft Office, and then click Microsoft Excel 2010. 

3. In Excel, on the Data tab, click From Other Sources, and then click From SQL Server. 
4. In the Server name box, type Contoso-SQL, and then click Next. 
5. From the Select the database that contains the data you want list, select ServerStatus, and 

then click Next. 
6. On the Save Data Connection File and Finish page, click Finish. 

 Note:  
If you are prompted to overwrite the ODC file, click Yes. 

7. On the Import Data dialog box, select the Table option, and then click OK. 

8. On the Data tab, click Connections. 

9. Select the ServerStatus data connection, and then click Properties. 

10. On the Connection Properties dialog box, on the Definition tab, click Authentication Settings. 

11. Select the SSS option, and in the SSS ID box, type the name of the Secure Store target 
application, VisioServicesData. 

12. Click OK. 

13. On the Connection Properties dialog box, click Export Connection File. 

14. In the File Save dialog box, type http://Contoso-AppSrv/sites/BICenter in the URL box, and then 
press Enter. 

 Note:  
It may take some time for the dialog box to refresh and show the site content. 

15. Double-click Data Connections. 

16. In the File name box, type ServerStatus.odc, and then click Save. 

17. On the Web File Properties dialog box, select Office Data Connection File from the Content 
Type drop-down list, and then click OK. 
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18. On the Connection Properties dialog box, click Cancel. 
19. On the Workbook Connections dialog box, click Close. 

20. Exit Excel. 

 Note:  
There is no need to save the Excel workbook. We have exported the ODC file and that is 
all we need to create a data connection from Visio. 

Remain logged on to the Contoso-Client virtual machine as Susan Burk. 
Now that the ODC file has been created and published, we can create a data-connected Web drawing. 

Create a data-connected Web drawing by using an 
ODC file 
In this section, we create a data-connected Web drawing, and then publish it to the document library in 
the Business Intelligence center. This helps us confirm that data refresh through Secure Store is 
working correctly. 
Use the following procedure to create the Web drawing. 

To create a data-connected Web drawing by using an ODC file 
1. Click Start, click All Programs, click Microsoft Office, and then click Microsoft Visio 2010. 

2. On the Choose a Template page, in the Template Categories section, click Network. 

3. Click Detailed Network Diagram, and then click Create. 

4. On the ribbon, click the Data tab, and then click Link Data to Shapes. 

5. On the Data Selector page of the wizard, click Previously created connection, and then click 
Next. 

6. On the Select Data Connection page, click Browse. 

7. On the Existing Connections dialog box, click Browse for More. 

8. In the Data Selector dialog box, type http://Contoso-AppSrv/sites/BICenter in the URL box, and 
then press Enter. 

 Note:  
It may take some time for the dialog box to refresh and show the site content. 

9. Double-click Data Connections. 

10. Click the ServerStatus data connection, and then click Open. 

11. On the Select Data Connection page, click Finish. 

12. On the blank drawing page: 

• Drag three Server icons from the Shapes area onto the page. 

• Drag each row from the data table in the External Data section to one of the shapes. 
Each shape should now have a data graphic connected to it indicating the server name and 
status (1 or 0). 

You should now have a diagram similar to the following. 
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 The next step is to publish the diagram as a data-connected Web 
drawing and then confirm that data refresh is working correctly. 
Use the following procedure to publish the drawing. 

To publish a data-connected Web drawing 
1. Click File, and then click Save & Send. 

2. Click Save to SharePoint. 
3. Under Locations, click Browse for a location. 

4. Under File Types, click Web Drawing. 

5. Click Save As. 

6. On the Save As dialog box, type http://Contoso-AppSrv/sites/BICenter in the location box at the 
top, and then press Enter. 

 Note:  
It may take some time for the dialog box to refresh and show the site content. 

7. In the All Site Content list, double-click  Documents. 

8. In the File name box, type Server Status, and then click Save. 
The Web drawing will render in a browser window. 

9. When the drawing is displayed, if a Refresh Disabled warning is displayed, click Enable (always). 
Note the server statuses displayed: 

• Seattle – Online (1) 

• New York – Online (1) 

• London – Offline (0) 
Leave this browser window open for the data refresh test procedure that follows. 

The rendered Web drawing shows the data currently in the ServerStatus database. To test the data 
refresh mechanism, we can modify the data in the Status table in SQL Server and then refresh the Web 
drawing to see the change. 
Use the following procedure to modify the data in SQL Server and then refresh the Web drawing. 
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 Note:  
Remain logged on to Contoso-Client as Susan Burk while you do this procedure. 

To test Visio Services data refresh 
1. Log into Contoso-SQL using the Contoso\SQLAdmin account. 

2. Click Start, click All Programs, click Microsoft SQL Server 2008 R2, and then click SQL Server 
Management Studio. 

3. On the Connect to Server dialog box, select Database Engine for the Server type, and then click 
Connect. 

4. In the toolbar, click New Query. 

5. Copy the following query to the query window: 
USE [ServerStatus] 
GO 
UPDATE dbo.Status set dbo.Status.status = 1 where dbo.Status.server = 'London' 
GO 

6. In the toolbar, click Execute. 

7. Return to Contoso-Client where the Server Status Web drawing is displayed. 
Note that the London server still shows Offline (0). 

8. On the Visio Web Access toolbar, click Refresh. 
Note that the London server now shows Online (1), reflecting the manual changes we made in SQL 
Server. 

 Note:  
The Visio Services cache settings affect how quickly the new results appear when you 
refresh the drawing. In this lab, we set the cache settings to zero (0), allowing immediate 
refresh. In a production environment, refresh will likely take longer depending on how you 
configure the cache. 

Other Resources 
Plan Visio Services security (SharePoint Server 2010) 
  

http://technet.microsoft.com/library/6d871772-b90b-4e48-9122-a6d9a1122b8d(Office.14).aspx�


 

 

Configure PerformancePoint Services for a BI 
test environment 
Published: May 26, 2011 

 Important:  
This article is part of the Configuring a BI infrastructure: Hands-on labs series. To complete the 
steps in this article, you must first have completed: 

• All steps in the Create a baseline environment for a BI test environment series of articles. 
PerformancePoint Services in Microsoft SharePoint Server 2010 is a performance-management service 
that you can use to monitor and analyze your business by using dashboards, scorecards, reports, and 
key performance indicators (KPIs).  
Deploying PerformancePoint Services consists of the following steps: 

• Creating an Active Directory account for the application pool under which the PerformancePoint 
Services service application will run 

• Registering that account as a managed account in Microsoft SharePoint Server 2010 

• Starting the PerformancePoint Service 

• Creating a PerformancePoint Services service application 
The first step in deploying PerformancePoint Services is to create an account in the Active Directory 
directory service to run the application pool for the PerformancePoint Services service application. Use 
the following procedure to create the account. 

To create an account for the application pool 
1. Log in to Contoso-DC by using the Contoso\administrator account. 

2. On the Contoso-DC virtual machine, click Start, click Administrative Tools, and then click Active 
Directory Users and Computers. 

3. Expand the contoso.local node. 

4. Right-click Users, click New, and then click User. 
5. In the Full name box and the User logon name box, type PPSAppPool. 
6. Click Next. 
7. In the Password and Confirm password boxes, type a password for the account. 

8. Clear the User must change password at next logon check box. 

9. Select the Password never expires check box. 

10. Click Next. 
11. Click Finish. 

12. Log off Contoso-DC. 
Once the Active Directory account has been created, it must be registered in SharePoint Server 2010 
before it can be used to run an application pool. Use the following procedure to register the account. 



 

To register a managed account 
1. Log on to Contoso-AppSrv by using the Contoso\FarmAdmin account. 

2. Click Start, click All Programs, click Microsoft SharePoint 2010 Products, and then click 
SharePoint 2010 Central Administration. 

3. On the SharePoint Central Administration Web site home page, in the left navigation, click 
Security. 

4. On the Security page, under General Security, click Configure managed accounts. 

5. On the Managed Accounts page, click Register Managed Account. 
6. In the User name box, type Contoso\PPSAppPool. 
7. In the Password box, type the password for the Contoso\PPSAppPool account. 

8. Click OK. 
By default, the application pool account does not have the required access to the SharePoint content 
database. Access to this database is required by PerformancePoint Services. Use the following 
procedure to grant the required database access to the application pool account. 

To grant content database access to the managed account 
1. On Contoso-AppSrv, click Start, click All Programs, click Microsoft SharePoint 2010 Products, 

right-click SharePoint 2010 Management Shell, and then click Run as Administrator. 
2. At the Windows PowerShell Command Prompt, type the following and press Enter after each line: 

$w = Get-SPWebApplication -identity http://contoso-appsrv 
$w.GrantAccessToProcessIdentity("Contoso\PPSAppPool") 

Once you have granted database access to the application pool account, you must start the 
PerformancePoint Service. This is the SharePoint Server 2010 service that performs all processing and 
activities associated with PerformancePoint Services. 
You must start this service on at least one application server. In a production environment, you would 
choose a server or servers on which to run the service, depending on your capacity requirements. 
Use the following procedure to start the PerformancePoint Service. 

To start the PerformancePoint Service 
1. On the Central Administration home page, under System Settings, click Manage services on 

server. 
2. Above the Service list, click the Server drop-down, and then click Change Server. 

Note that the application server, Contoso-AppSrv, is listed together with Contoso-SQL. In a farm 
that has multiple application servers, you would use this dialog box to select the server where you 
want to run Secure Store Service, and then start the service as shown later in this article. 

3. Click CONTOSO-APPSRV. 

4. In the Service list, click Start next to PerformancePoint Service. 
Once the PerformancePoint Service has been started, you must create a PerformancePoint Services 
service application. Use the following procedure to create the service application. 

To create a PerformancePoint Services service application 
1. On the Central Administration home page, under Application Management, click Manage service 

applications. 
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2. On the Manage Service Applications page, click New, and then click PerformancePoint Service 
Application. 

3. In the Name section, type PerformancePoint Services in the box. 

4. Select the Add this service application’s proxy to the farm’s default proxy list check box. 

5. Select the Create new application pool option and type PPSAppPool in the Application pool 
name box. 

6. Select the Configurable option and, from the drop-down list, select CONTOSO\ppsapppool. 
7. Click Create. 

8. When the service application has been successfully created, click OK. 
When you have completed all of the previous procedures, PerformancePoint Services is operational 
and ready to use. The next step is to configure security access to your data sources. The following lab 
covers configuring security access by using Secure Store Service: 

• Configure data access for PerformancePoint Services 
  



 

 

Configure data access for PerformancePoint 
Services 
Published: May 26, 2011 

 Important:  
This article is part of the Configuring a BI infrastructure: Hands-on labs series. To complete the 
steps in this article, you must first have completed: 

• All steps in the Create a baseline environment for a BI test environment series of articles. 

• All steps in Configure PerformancePoint Services for a BI test environment 
PerformancePoint Services uses an unattended service account to connect to database servers. By 
using the unattended service account involves configuring an Active Directory account access to your 
data, storing the credentials for this account in Secure Store, and configuring PerformancePoint 
Services to use this account to access data. 
The following steps are required to configure data access in PerformancePoint Services. 

• Configure a data access account 

• Configure the unattended service account 

• Verify that user permissions are configured correctly 
The first step is to create an Active Directory account for use as the unattended service account. 

Configure a data access account 
To configure a data access account for PerformancePoint Services, we begin by creating an Active 
Directory account. 

To create an Active Directory account for data access 
1. Log into Contoso-DC as Contoso\Administrator. 

2. Click Start, click Administrative Tools, and then click Active Directory Users and Computers. 

3. Expand the contoso.local node. 

4. Right-click Users, click New, and then click User. 
5. In the Full name and User logon name text boxes, type PPSUnattended. 

6. Click Next. 
7. Type and confirm a password for the account. 

8. Clear the User must change password at next logon check box. 

9. Select the Password never expires check box. 

10. Click Next, and then click Finish. 
Next, we create a SQL Server logon. This account will be used to view data that is stored in SQL 
Server.  

To create a SQL Server logon 



 

1. Log in to Contoso-SQL as Contoso\SQLAdmin. 

2. Click Start, click All Programs, click Microsoft SQL Server 2008 R2, and then click SQL Server 
Management Studio. 

3. On the Connect to Server dialog box, select Database Engine as the Server type, type 
Contoso-SQL in the Server name text box, and then click Connect. 

4. In Object Explorer, expand Security. 

5. Right click Logins, and then click New Login. 

6. In the Login name text box, type Contoso\PPSUnattended. 

7. Under Select a page, click User Mapping. 

8. Select the Map check box for the ContosoRetailDW database, and then under Database role 
membership for: ContosoRetailDW, select the db_datareader check box. 

9. Click OK. 
Now that the data access account is configured, the next step is to configure the unattended service 
account for PerformancePoint Services. 

Configure the unattended service account 
To configure the unattended service account, we begin by specifying an unattended service account for 
PerformancePoint. We do this by editing PerformancePoint Services Global Settings.  

To configure PerformancePoint Services Global Settings 
1. Log into Contoso-AppSrv as Contoso\FarmAdmin. 

2. Click Start, click All Programs, click Microsoft SharePoint 2010 Products, and then click 
SharePoint 2010 Central Administration.  

3. On the Central Administration home page, under Application Management, click Manage service 
applications. 

4. On the Manage Service Applications page, click PerformancePoint Services. 

5. On the Manage the PerformancePoint Services page, click PerformancePoint Service 
Application Settings. 

6. On the PerformancePoint Service Application Settings page, in the SecureStore and Unattended 
Service Account section: 

a) In the User Name text box, type Contoso\PPSUnattended. 

b) In the Password text box, type the password for the Contoso\PPSUnattended account. 

7. Click OK. 
Now that we have configured PerformancePoint Services, the next step is to test connectivity. We do 
this by creating a PerformancePoint data connection. 

To test PerformancePoint Services connectivity 
1. In the Business Intelligence Center (http://contoso-appsrv/sites/BICenter), click Monitor Key 

Performance, and then click Start using PerformancePoint Services. 
The PerformancePoint site template opens. 

2. Click Run Dashboard Designer.  
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3. In the Application Run – Security Warning dialog box, click Run. 
Dashboard Designer opens. 

4. In the Workspace Browser, click Data Connections. Then, on the Create tab in the ribbon, click 
Data Source. 
The Select a Data Source Template dialog box opens. 

5. In the Category pane, click All, and in the Template pane, click SQL Server Table. Then click OK. 
The data connection opens for editing. 

6. In the center pane, on the Editor tab, specify the following settings: 

a) In the Connection Settings section, select Use Standard Connection. 

b) In the Server box, type Contoso-SQL. 

c) Use the Database list to select ContosoRetailDW. 

d) Use the Table list to select dbo.DimProductCategory. 

7. In the Data Source Settings section, click Test Data Source. If the connection is successful, then 
the unattended service account is configured correctly. 

8. In the center pane, click the Properties tab. In the Name box, type Product Categories. 

9. In the Workspace Browser, right-click the data connection, and then click Save. 
This saves the data connection that you previously created to the Data Connections list in the 
Business Intelligence Center. 

10. In the Business Intelligence Center (http://contoso-appsrv/sites/bicenter), click Data Connections. 
Notice the data source that you created is listed in the Data Connections document library. 

11. Close Dashboard Designer. If a Dashboard Designer dialog box opens that prompts you to save 
changes to dashboard items, click Don’t Save. 

 Note:  
By default, PerformancePoint dashboard items are saved to the following SharePoint list 
and libraries in the Business Intelligence Center: 

• Data connections are saved to the Data Connections list 

• Key performance indicators (KPIs), scorecards, reports, dashboard pages, and dashboard 
filters are saved to the PerformancePoint Content list 

• Published dashboards are saved to the Dashboards document library 
By saving items as we create them one at a time, any changes to those items are 
automatically saved to SharePoint Server. For example, we saved our data connection 
to SharePoint Server in Step 8. 
When you see the Dashboard Designer dialog box that prompts you to save changes 
to items, you are actually being asked whether you want to create a workspace file that 
you would then save to your local computer. The workspace file does not contain the 
actual dashboard items, but does contain definitions of those dashboard items, which is 
useful for dashboard content migration scenarios that are not covered in these labs.  

12. Log off the Contoso-AppSrv computer.  
Now that PerformancePoint Services is enabled and configured, the next step is to verify that user 
permissions are assigned correctly.  

http://contoso-appsrv/sites/bicenter


 

Verify that user permissions are configured correctly 
During the process of setting up the BI test environment, we created certain accounts and groups, and 
we assigned permissions for those accounts. These accounts and permissions are summarized in the 
following table: 
  

User Name Group Permissions 

Contoso\Jill.Frank None. None. 
 

Contoso\John.Woods BICenterRead Read 
Read permissions 
enable users to view 
information in the 
Business Intelligence 
Center. 

Contoso\Susan.Burk BICenterContribute Contribute 
Contribute 
permissions enable 
users to view and 
create items, such as 
reports, and save 
them to this site.  

Contoso\Cindy.White BICenterDesign Design 
Design permissions 
enable users to view, 
create, and publish 
items that include 
dashboards. 

Contoso\David.Hamilton BICenterFullControl Full Control 
Full Control 
permissions enable 
users to view, create, 
and publish 
dashboard content, 
and to view or edit 
user permissions 

  
To verify that user permissions are configured correctly, we will log on to the Contoso-Client computer 
by using each user’s credentials and attempt to perform one or more tasks that are subject to user 
permissions restrictions. These procedures help show how permissions work with PerformancePoint 
Services and the Business Intelligence Center. 
We begin by verifying that unauthorized users cannot access the Business Intelligence Center. 



 

Verifying that unauthorized users cannot access the Business 
Intelligence Center 
Contoso\Jill.Frank was not assigned permissions to access the Business Intelligence Center. To verify 
that unauthorized users cannot view information in the Business Intelligence Center, we attempt to 
open the Business Intelligence Center by using Jill’s user credentials.  

To attempt to open the Business Intelligence Center by using an unauthorized 
account 
1. Log into the Contoso-Client computer by using the Contoso\Jill.Frank user account. 

2. Open a web browser. 

3. In the address line, type http://contoso-appsrv. 
The main team site opens. 

4. In the Quick Launch, click Business Intelligence Center. 
You receive an Error: Access Denied message.  

5. Log off the Contoso-Client computer. 
The error message indicates that Jill Frank does not have permissions to access the Business 
Intelligence Center. This confirms that user permissions are configured correctly for this user account. 
Next, we will verify that Read permissions are working correctly.  

Verifying that Read permissions are configured correctly 
John Woods was assigned Read permission, which means he should be able to view, but not edit, 
content in the Business Intelligence Center. Users who have Read permissions can also open 
Dashboard Designer. However, they cannot create PerformancePoint dashboard content. 
To verify that Read permissions are configured correctly, we will attempt to create a KPI using the 
Contoso\John.Woods account.  

To attempt to create a KPI by using Dashboard Designer 
1. Log into the Contoso-Client computer by using the Contoso\John.Woods user account. 

2. Open a web browser. 

3. In the address line, type http://contoso-appsrv. 
The main team site opens. 

4. In the Quick Launch, click Business Intelligence Center. 
The Business Intelligence Center opens.  

5. In the Business Intelligence Center, click Monitor Key Performance, and then click Start using 
PerformancePoint Services. 
The PerformancePoint site template opens. 

6. Click Run Dashboard Designer. 
7. In the Application Run – Security Warning dialog box, click Run. 

Dashboard Designer opens. 
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 Important:  
Dashboard Designer will open for all users who have at least Read access assigned on the 
Business Intelligence Center. However, users who have only Read permissions assigned 
will be unable to create any items by using Dashboard Designer. 

8. In the Workspace Browser, click PerformancePoint Content. 
9. Click the Create tab, and then click KPI.  

The Select a KPI Template dialog box opens. 

10. Select Blank KPI, and then click OK. 
You receive an error message that indicates that you do not have permissions to create a KPI.  

11. Close Dashboard Designer. If a Dashboard Designer dialog box opens that prompts you to save 
changes to dashboard items, click Don’t Save. 

12. Log off the Contoso-Client computer.  
The error message appeared when you tried to create a KPI indicates that John Woods does not have 
permissions to create items by using Dashboard Designer. This confirms that user permissions are 
configured correctly for this user account. 
Next, we will verify that Contribute permissions are working correctly.  

Verifying that Contribute permissions are configured correctly 
Susan Burk was assigned Contribute permissions, which means she should be able to create 
dashboard items, such as reports, scorecards, filters, and dashboard pages. However, Susan should 
be unable to publish dashboards. To verify that users who have Contribute cannot publish dashboards, 
we will attempt to create and publish a dashboard that contains a scorecard by using the 
Contoso\Susan.Burk account.  
We begin by creating a basic scorecard that uses fixed values that we will specify. 

To create a basic scorecard 
1. Log into the Contoso-Client computer by using the Contoso\Susan.Burk user account. 

2. Open a web browser. 

3. In the address line, type http://contoso-appsrv. 
The main team site opens. 

4. In the Quick Launch, click Business Intelligence Center. 
The Business Intelligence Center opens.  

5. In the Business Intelligence Center, click Monitor Key Performance, and then click Start using 
PerformancePoint Services. 
The PerformancePoint site template opens. 

6. Click Run Dashboard Designer. 
7. In the Application Run – Security Warning dialog box, click Run. 

Dashboard Designer opens. 

8. In the Workspace Browser, click PerformancePoint Content. 
9. Click the Create tab, and then click Scorecard.  

The Select a Scorecard Template dialog box opens. 
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10. In the Category pane, select Standard, and in the Template pane, select Fixed Values 
Scorecard. Then click OK. 
The Create a Fixed Values Scorecard wizard opens. 

11. On the Select KPIs to Import page, specify the following: 

• In the KPI Name column, select the default text that says “New KPI”, and then type Unit Sales. 

• In the Actual column, type a number, such as 500. 

• In the Target column, type a number, such as 525. 
Then, click Next. 

12. On the Locations page, verify that the Create KPIs in list has PerformancePoint Content, and 
then click Finish. 
The scorecard opens for editing. 

13. In the center pane, click the Properties tab. 

14. In the Name box, type Sales Scorecard. 

15. In the Workspace Browser, right-click the scorecard, and then click Save. 
This saves the scorecard to the PerformancePoint Content list in the Business Intelligence Center. 

The basic scorecard is completed. The next step is to create a dashboard page. (Contribute 
permissions enable users to create but not publish dashboard pages.)  

To create a dashboard page 
1. On the Create tab, in the Dashboard Items group, click Dashboard. 

The Select a Dashboard Page Template dialog box opens. 

2. Select 1 Zone, and then click OK. 
The dashboard opens for editing. 

3. Notice that in the Workspace Browser, the text “New Dashboard” is highlighted. Type Sales 
Dashboard, and then press the Enter key to rename the dashboard. 

4. In the Details pane, expand Scorecards, and then expand PerformancePoint Content. 
5. Drag the Sales Scorecard to the zone in the Dashboard Content section. 

6. In the Workspace Browser, right-click the Sales Dashboard, and then click Save. 
This saves the dashboard page to the PerformancePoint Content list in the Business Intelligence 
Center. 

As expected, Susan was able to create a scorecard and a dashboard page. The next step is to attempt 
to publish the dashboard. 

To attempt to publish a dashboard 
1. In the Workspace Browser, right-click the Sales Dashboard, and then click Deploy to 

SharePoint. 
The Deploy To dialog box opens. 

2. Keep the default settings, and then click OK. 
You receive an error message that indicates that you cannot deploy the dashboard. The message 
indicates that the document library “sites/BICenter/Dashboards” is unavailable. 

3. Close Dashboard Designer. If a Dashboard Designer dialog box opens that prompts you to save 
changes to dashboard items, click Don’t Save. 



 

The error message that opened when Susan tried to publish a dashboard indicates that she does not 
have sufficient permissions to perform that task. This confirms that user permissions are configured 
correctly for this user account. 
Next, we will verify that Design permissions are working correctly.  

Verifying that Design permissions are configured correctly 
Cindy White was assigned Design permissions, which means she should be able to view, create, and 
edit dashboard items, such as reports, scorecards, filters, and dashboard pages. In addition, Cindy 
should be able to publish dashboards. However, users who have Design permissions should be unable 
to view or edit user permissions for the Business Intelligence Center. To verify that Design permissions 
are configured correctly, we will first publish the dashboard that we created earlier in this article. Then, 
we will attempt to view and edit user permissions for the dashboard by using the Contoso\Cindy.White 
account.  
We begin by publishing the Sales Dashboard. 

To publish the Sales Dashboard 
1. Log into the Contoso-Client computer by using the Contoso\Cindy.White user account. 

2. In the address line, type http://contoso-appsrv. 
The main team site opens. 

3. In the Quick Launch, click Business Intelligence Center. 
The Business Intelligence Center opens.  

4. In the Business Intelligence Center, click Monitor Key Performance, and then click Start using 
PerformancePoint Services. 
The PerformancePoint site template opens. 

5. Click Run Dashboard Designer. 
6. In the Application Run – Security Warning dialog box, click Run. 

Dashboard Designer opens. 

7. In the Workspace Browser, click PerformancePoint Content. 
8. In the center pane, on the SharePoint tab, double-click Sales Dashboard to open it for editing. 

9. In the Workspace Browser, right-click the Sales Dashboard, and then click Deploy to 
SharePoint. 
The Deploy To dialog box opens. 

10. Keep the default settings, and then click OK. 
The dashboard is published to SharePoint Server and opens in a web browser. 
Keep this window open. 

The dashboard has published successfully. The next step is to attempt to view and edit user 
permissions. 
There are two ways to view or edit user permissions: 

• You can use the Item Permissions toolbar command in a SharePoint list or library 

• You can use the Permissions toolbar command in Dashboard Designer 
We will attempt to view and edit user permissions by using both methods. 

http://contoso-appsrv


 

We begin by trying to view and edit permissions by using the Item Permissions toolbar command in the 
PerformancePoint Content list. 

To attempt to view and edit item permissions in a SharePoint list 
1. In the browser window where the dashboard is displayed, in the Quick Launch, click 

PerformancePoint Content. 
The PerformancePoint Content SharePoint list opens and displays the dashboard items that we 
created earlier by using the Contoso\Susan.Burk account. 

2. Locate an item, such as the Sales Scorecard, and select the check box to the left of the item’s 
name. 

3. In the ribbon, click the Items tab. Notice that in the Manage group, the Item Permissions toolbar 
command is not enabled. 
This indicates that Cindy White cannot view or edit user permissions for dashboard items. 

Now we attempt to view and edit user permissions by using the Permissions toolbar command in 
Dashboard Designer. 

To attempt to view and edit user permissions in Dashboard Designer 
1. In Dashboard Designer, in the Workspace Browser, click PerformancePoint Content. 
2. On the Home tab, in the Item group, click Permissions. 

You receive an Error: Access Denied message. 
The error message indicates that you do not have permissions to view and edit user permissions 
for PerformancePoint dashboard content. 

3. Close the page that displays the error message, and then close Dashboard Designer. If a 
Dashboard Designer dialog box opens that prompts you to save changes to dashboard items, click 
Don’t Save. 

4. Log off the Contoso-Client computer.  
Cindy White can create and edit dashboard items and publish dashboards, but she cannot view or edit 
user permissions. This confirms that user permissions are configured correctly for this user account. 
Next, we will verify that Full Control permissions are working correctly.  

Verifying that Full Control permissions are configured correctly 
David Hamilton was assigned Full Control permissions, which means that he can view, create, and edit 
dashboard items. In addition, David Hamilton can publish dashboards and view or edit user permissions 
for dashboard content. 
We can verify this by viewing user permissions for the Sales Scorecard that was created and published 
earlier in this article. 
We will use two methods to view and edit permissions:  

• We will use the Item Permissions toolbar command in the PerformancePoint Content list 

• We will use the Permissions toolbar command in Dashboard Designer 

To view or edit item permissions in a SharePoint list 
1. Log into the Contoso-Client computer by using the Contoso\David.Hamilton user account. 

2. In the address line, type http://contoso-appsrv. 

http://contoso-appsrv


 

The main team site opens. 

3. In the Quick Launch, click Business Intelligence Center. 
The Business Intelligence Center opens.  

4. In the Quick Launch, click PerformancePoint Content. 
The PerformancePoint Content SharePoint list opens and displays the dashboard items that we 
created earlier by using the Contoso\Susan.Burk account. 

5. Locate an item, such as the Sales Scorecard, and select the check box to the left of the item’s 
name. 

6. In the ribbon, click the Items tab, and in the Manage group, click the Item Permissions toolbar 
command. 
A permissions page opens, where you can view or edit user permissions. 

To view or edit user permissions in Dashboard Designer 
1. In the browser window, in address line, type http://contoso-appsrv. 

The main team site opens. 

2. In the Quick Launch, click Business Intelligence Center. 
The Business Intelligence Center opens.  

3. In the Business Intelligence Center, click Monitor Key Performance, and then click Start using 
PerformancePoint Services. 
The PerformancePoint site template opens. 

4. Click Run Dashboard Designer. 
5. In the Application Run – Security Warning dialog box, click Run. 

Dashboard Designer opens. 

6. In Dashboard Designer, in the Workspace Browser, click PerformancePoint Content. 
In the center pane, the Unit Sales KPI, Sales Scorecard, and Sales Dashboard are listed. 

7. Double-click Sales Scorecard to open it for editing.  

8. On the Home tab, in the Item group, click Permissions. 
A permissions page opens, where you can view or edit user permissions. 

9. Close the permissions page, and then close Dashboard Designer. If a Dashboard Designer dialog 
box opens that prompts you to save changes to dashboard items, click Don’t Save. 

10. Log off the Contoso-Client computer.  
You have successfully configured PerformancePoint Services. 

Concepts 
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Enable Reporting Services in an integrated 
SharePoint Server BI test environment 
In our baseline configuration, SQL Server Reporting Services is installed in native mode.  To use any of 
the Reporting Services features on SharePoint Server such as PowerPivot, Access Services, or Report 
Builder 3.0, you must change your configuration of SQL Server Reporting Services to SharePoint 
integrated mode. The articles in this section instruct how to change from native to integrated mode and 
how to configure and start Report Builder 3.0 from the Business Intelligence Center. 
In this section: 

• Changing SQL Reporting Services from Native mode to Integrated mode in a BI test environment 

• Configure Report Builder 3.0 for use in SharePoint BI test environment 
  



 

 

Changing SQL Reporting Services from Native 
mode to Integrated mode in a BI test 
environment 
Published: February 7, 2012 
In our baseline configuration, SQL Server Reporting Services is installed in native mode.  To use any of 
the Reporting Services features on SharePoint such as PowerPivot, Access Services, or Report Builder 
3.0, you must change your configuration of SQL Server Reporting Services to SharePoint integrated 
mode. This article describes the steps that are required to switch to integrated mode. 

Install SharePoint Server 2010 components on the 
Reporting Server computer 
To use a reporting server in the SharePoint farm, you first have to install SharePoint Server 
components on the Contoso-SQL computer. 

 Note:  
You must have an internet connection to perform this procedure.  Refer to Create a baseline 
environment for a BI test environment for instructions.  

To install SharePoint Server 2010 prerequisites 
1. Log on to the Contoso-SQL virtual machine with the Contoso\SQLAdmin account.   

2. On the SharePoint Server 2010 DVD, run default.hta. 

3. On the SharePoint Server 2010 opening page, click Install software prerequisites. 

4. Follow the wizard to complete installation of all prerequisites. 

 Note:  
Depending on your configuration, you may have to restart your computer during this 
process. 

5. When the wizard has finished, click Finish. 
Once the prerequisites are installed, you can install SharePoint Server 2010 itself. Perform the following 
procedure to install SharePoint Server 2010 on Contoso-AppSrv. 

To install SharePoint Server 2010 
1. On the SharePoint Server 2010 DVD, run default.hta. 

2. On the SharePoint Server 2010 opening page, click Install SharePoint Server. 
3. On the Enter your Product Key page, type your product key, and then click Continue. 

4. On the Read the Microsoft Software License Terms page, read the license agreement and accept 
the terms by selecting the I accept the terms of this agreement check box. 

5. Click Continue. 



 

6. On the Choose the installation you want page, click Server Farm. 

7. On the Server Type page, select the Complete – Install all components option. 

8. Click Install Now. 

9. On the Run Configuration Wizard page, leave the Run the SharePoint Products and 
Technologies Configuration Wizard now check box selected, and then click Close. 

10. On the Welcome to SharePoint Products page, click Next. 
11. On the warning dialog box, click Yes. 

12. On the Connect to a server farm page, select the Connect to an existing server farm option, and 
then click Next. 

13. On the Specify Configuration Database Settings page: 

a) In the Database server box, type the name of the database server (Contoso-SQL). 

b) In the Database name text box, keep the default database name of SharePoint_Config. 

c) Type the user name and password of the database access account (Contoso\SQLAdmin).  

d) Click Next. 

 Note:  
If the wizard cannot connect to Contoso-SQL, check the firewall settings in Windows Server. 

e) On the Completing the SharePoint Products and Technologies Configuration Wizard page, 
click Next. 

f) Select Do not use this machine to host the web site.  Click OK.  

g) On the Configuration Successful page, click Finish. 

Configure SSRS in SharePoint integrated mode 
To configure SSRS in SharePoint integrated mode 
1. Log on to Contoso-SQL as Contoso\SQLAdmin.  

2. Click Start, select All Programs, Microsoft SQL Server 2008 R2, and Configuration Tools, and 
then click Reporting Services Configuration Manager. 

3. In the baseline line configuration, SQL Server Reporting Services is installed on the default 
instance. The server name CONTOSO-SQL and the report server instance, MSSQLSERVER, are 
shown as the defaults.  Click Connect.  

4. On the report server status page, notice that the current Report Server mode is Native. 

5. From the left navigation pane, click Database.  

6. Click Change Database. 

7. Select Create a new report server database, and then click Next. 
8. Accept defaults for server name and credentials. Click Next. 
9. In the Database Name box type BILabReportServer and change Report Server Mode to 

SharePoint integrated mode. Click Next. 
10. Accept the default credentials and then click Next. 
11. Verify the summary, and make sure that Report Server Mode is set to SharePoint integrated 

mode.  Click Next. 



 

12. Click Finish. 

13. In the left navigation pane of Reporting Services Configuration Manager, click Web service 
URL, and then click the URL link to open it. 

 Note:  
You will receive an error because you must still configure Reporting Services integration in 
SharePoint Server. 

Configure SharePoint Server 2010 for Reporting 
Services integration 
Finish the configuration of integrating Reporting Services with SharePoint Server 2010 by completing 
the following steps: 

To configure SharePoint Server 2010 for Reporting Services integration 
1. Log on to Contoso-AppSrv as Contoso\FarmAdmin. 

2. Open SharePoint Central Administration. 

3. On the left navigation pane, click General Application Settings.  In the center page in the 
Reporting Services section, click Reporting Services Integration. 

4. In the Report Server Web Service URL field, type http://CONTOSO-SQL/REPORTSERVER. 

5. In the Authentication Mode section, select Trusted Account. 
6. In the Credentials box, enter the user name CONTOSO\SQLAdmin and the password. 

7. In the Activate the reporting services feature section, select Activate feature in all existing site 
collections. 

8. Click OK. 
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Configure Report Builder 3.0 for use in 
SharePoint BI test environment 
Published: February 7, 2012 
When you are using the BI Center template, the Microsoft SQL Server Reporting Services (SSRS) 
content types are already available.  However, as we have switched to SQL Server Reporting Services 
integration after the initial installation, you must manually enable the SQL Server Reporting Services 
content types.  

Enable content type management 
To enable content type management 
1. Open the library for which you want to enable multiple content types. On the library menu bar, you 

should see the following menus: New, Upload, Actions, and Settings. If you do not see Settings, 
you do not have permission to add a content type. 

2. On the Library Tools ribbon tab, click the Library tab. 

3. On the Settings ribbon group, click Library Settings. 

4. In the General Settings section, click Advanced settings. 

5. In the Content Types section, select Yes to allow management of content types.  

6. Change any other settings that you want, and then click OK. 

Add Report Server content types 
To add Report Server content types to the document library on the BI Center 
1. Go the BI Center, and from the Quick Launch pane, click Documents. 

2. On the Library Tools ribbon tab, click the Library tab. 

3. On the Settings ribbon group, click Library Settings. 

4. In the Content Types section, click Add from the existing site content types.  

5. In the Select Content Types section, in Select site content types from, click the arrow to select 
Reporting Services.  

6. In the Available Site Content Types list, click Report Builder, and then click Add to move the 
selected content type to the Content types to add list.  

7. To add Report Model and Report Data Source content types, repeat steps 5 and 6.  

8. Click OK. 

Concepts 
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